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Abstract

KDevelop is an Integrated Development Environment to be used for a wide
variety of programming tasks.
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Chapter 1

What This Manual Contains

This user manual is intended to describe the contents and use of the KDevelop
3.1.0 Integrated Development Environment (IDE) from a user’s point of view.
It is not a programming manual, nor does it describe the development process
in detail. Its only aim is to guide you in the handling of the IDE.

Here you will find information on the following topics:

Getting Started with KDevelop — a Guided Tour Gives you a quick start on
the use of this IDE, introducing the basic steps of how to work on a
project.

Overview of the Features of KDevelop Extends the guided tour in the previ-
ous chapter, giving an overall view of what is built-in within KDevelop
and gets you acquainted with the look and feel of this IDE.

Configuring KDevelop Shows how you can tailor the IDE to suit your needs.

Getting started: the Application Wizard Describes the basics of how to set up
a new project in KDevelop using the built-in Application Wizard.

Editing tools All you need to write your source files: using the editor, search-
ing for text both locally and project-wide, up to integrating new files and
classes into the project.

The File Browsers Demonstrates various tools to look at the structure of your
project and how to access the files you want to work with.

The Class Browsers Describes one of the most powerful tools of KDevelop
which lets you navigate through class dependencies and allows you to
easily create and access the classes and methods you need.

Documentation Shows how to access the rich built-in documentation KDe-
velop provides and tells you how to create documentation of your project,

concise and powerful API documentation providing you an overall view
of all your project sources as well as docbook-based user documentation.
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Building and Project Management Deals with the creation and management
of your project; describing the basics of autoconf and automake as well
as how to set up custom make files and how to use compiler or make
options to tailor your application to suit your needs.

Advanced Build Management Looks at ways to keep multiple build configu-
rations, to cross-compile for diverse platforms, or to make an embedded
system using the Qt/embedded library.

The Debugger Interface Describes how to use the integrated gdb debugger
interface so you can hunt down bugs without leaving KDevelop.

Using CVS Tells you how you can maintain your project using the CVS ver-
sioning system; a must, especially if many developers work on the same
project.

Some commonly used information has been put into the appendix. Amongst
others this consists of:

Installing KDevelop Tells you where to obtain KDevelop and how to get it up
and running.

In a Nutshell — Tips and Tricks A quick reference to commonly used com-
mands and actions. And a short guide to solve common problems when
working with KDevelop.

Development on UNIX A historical overview of UNIX® program develop-
ment, the main tools necessary and why you need an IDE.

Configuration Files Used by KDevelop Lists the files KDevelop uses to save
its internal information. This is particularly useful in case something
went wrong with your setup.

Plugin Tools Lists the pluggable tools you can use to taylor the capabilities
of KDevelop to your needs.

KDevelop User Interface Mode Examples Shows user interface modes.
Further Information Getting Information, reporting Bugs etc.
Changelog Shows the history of this documentation.

Bibliography Bibliography
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Chapter 2

Getting Started with
KDevelop — a Guided Tour

Bernd Pol Now that you have installed your KDevelop IDE, how are you going
to make good use of it? As this is a complex application, the learning curve
may be somewhat steep, especially if you are not already used to this type of
an Integrated Development Environment.

We will try to soften this learning curve a bit by stepping through the makings
of a simple KDE C++ application. Thereby we will have a (cursory) look at:

What is there seen on the surface of the KDevelop IDE.
How to create a new project.

2.1 A Very First Look at KDevelop

2.1.1 On the Surface

When you start KDevelop for the first time you will get a display similar to this
one:
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=% KDevelop -0 x]
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The KDevelop initial layout

Workspace Area and Tool View Tabs In this initial case KDevelop uses the so-
called IDEAI user interface mode. A workspace area of maximum possible size
is surrounded left, bottom, and right by a series of buttons which act similar to
tabs on a tabbed display. If you click on one of those tabs, a so-called tool view
window will open which allows you to work on a specific task.

Menu and Toolbars On top there is the usual menubar, followed by several
rows of toolbars, some being initially empty. They will get populated once
there is a project opened for actual work.

Status Bar Finally there is a status bar on the bottom of the window displaying
short information on several tasks.

2.1.2 How to Get Some Help

Besides the Help which offers answers to specific questions, the status bar and
two kinds of tooltips provide some quick information.

What Does This Menu Entry Do? When you place the mouse cursor on a
menu entry, some short information will usually be displayed in the status bar.
While in most cases this repeats just the name of the selection, in some cases it
will provide additional information about the purpose of the menu command.
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What Is the Name of This Item? On many items a short function name tooltip
will pop up when you place the cursor on it for a few seconds. This is useful
for quick orientation on toolbar or tool view tabs in IDEAl mode when the IDE
has been set up to display icons only on these buttons.

What Does This Item Do? More information is available through expanded
tooltip help for many items on the IDE. Select Help — What’s This? or press
Shift-F1, then with the question mark cursor select the item you want to know
more of. You can as well open any menu this way and click on a specific menu
entry (active as well as greyed disabled ones) to see if more information is
available.

2.1.3 Whatis in the menus

There are ten menus selectable on the menubar. Most of them get fully popu-
lated once a project is opened for actual work while others need a document
opened at least. In short, they will allow the following action types.

This is only an overview. For a detailed listing of the menus and their items,
see the Command Reference.

File Usual Actions This is pretty standard. It allows to create, open, save,
print, and close document files as well as quitting the KDevelop applica-
tion as usual.

Revert Changes Additionally it allows to revert changes by reloading file
contents in an orderly way.

Edit This menu is useful only if a document is opened.

Usual Actions It provides the usual undo/redo and cut/copy/paste ac-
tions. Furthermore it allows to select text blocks in various ways.

Search and Replace There is a very powerful search facility available
on the Edit menu. In addition to the usual search and replace actions
limited to the current document you may as well conduct global search
and replace actions. This allows to work on all files of the project in a
single turn.

Advanced Text Edit There are provisions to reformat the current docu-
ment and to automatically complete partially typed texts in various ways.

View Like the Edit menu, this menu is useful only if there is a project currently
open. I this case there will be the following actions available (amongst
others):

Navigation History Switch back and forth through the documents etc.
you visited.

Error Tracking Navigate to the source lines of the errors encountered in
the most recent compilation/build process.

Manage Tool View Select or hide tool view windows or tool view docks.

Editor Related Acions Some entries in the View menu control the look
and view of the editor you use. In case of the Kate Part (Embedded Ad-

vanced Text Editor) there will be the following controls available:
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e Control the word wrap behaviour in the document window.

e Show or hide several border displays in the document windows: line
numbers, icons, and, additionally, bookmark marks in the scroll bar.

o Control the display of folded (temporarily hidden) sections in a source
text.

Project All work of KDevelop is based on projects which basically collect source
files, build management files, and other information in one project direc-
tory. In this menu you control which project to use, which properties it
has, and some other managing actions. In particular:

Open a Project Allows to create new projects, open existing ones, and
import projects from other environments.

Project Options Allows to define a whole bunch of different project prop-
erties.

Classes Management Add new classes to the project and traverse the
inheritance tree of a class.

Distribute Project Helps to build distribution packages of the project.

Build This menu is all about compiling and documenting the project. Thus it
is of use only when a project is actually open. In this case it provides the
following actions:

Compile, Link, Execute Allows to compile and link the whole project or
parts of it as well as run the application from within the IDE.

Prepare Build Operations This actually depends on the make system
you use for this project. In the case of automake projects it allows to
runMakefile.cvs and configure on their own. There are also provisions
to remove translated files from the project in various stages of intensity.

Install the Application Allows to install the application both in local di-
rectories as well as in system directories only accessible to the root user.

API Documentation Build or remove a doxygen-based API documenta-
tion of the project as defined in the project options.

Debug Although this menu will be filled once a project is active, it of course
is useful only if the actual project has been previously compiled with
debugging information (this is basically set up in Project — Project Op-
tions..). There are the following actions available in this case:

Usual Debugger Actions The first section in the Debug provides a graph-
ical interface to the GDB GNU symbolic debugger. It allows to start and
stop your application in the debugger and step through it in various
ways.

Breakpoints KDevelop provides several means to set breakpoints in your
application sources. One is through the use of the Toggle Breakpoint
menu entry.

Advanced Debugging Other Debug menu entries allow more sophisti-

cated program analysis. Use Shift-F1 to get more information about their
purpose.
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Window This is fairly standard. You may select any open document window
as well as close one or more documents windows in here. You may even
select a set of document windows to be closed in one single turn.

Tools KDevelop is highly customizable. You may select a favorite editor for
your documents as well as provide external and plugged-in tools to ex-
tend the basic IDE capabilities. The Tools menu reflects most of this setup.

Advanced Editing The upper set of Tools menu entries will be provided
by the editor plugin which is in use. You may select your favorite edi-
tor via Settings — Configure KDevelop...+Editor. Once an editable doc-
ument file is selected, the upper part of the Tools menu will provide ad-
vanced editing commands specific to the editor part in use.

Web Side Handling In case the active document window contains a HTML
page (e.g. displayed from a Documentation selection), the Tools will
show additional menu entries which provide various means to handle
Web pages.

Other Tools Usually there will be a bunch of other entries according to
the currently available tools. Use Shift-F1 to get more information about
their purposes.

Settings This menu allows you to show and hide menubar, toolbars and sta-
tusbar. Also, you can configure shortcuts, toolbars, notifications, the edi-
tor and KDevelop’s general behavior.

Help Here you can open this KDevelop manual, read Qt documentation, open
man pages (the traditional UNIX manual format) and info pages (the
GNU manual format), report bugs and get some info about your current
KDevelop version and its authors.

2.2 How to Start a New Project — the Application
Wizard

This is to show you how easy it is to make KDevelop create a running program
for you.

The Application Wizard can quickly create a project for you from a list of pre-
defined project templates. All you have to do is select the type of project you
want, how to name it, and where to put it.

Select Project - New Project. The Create New Project Window appears. Let’s
assume you want to create a normal KDE project. So select the type: C++ -
KDE - Simple KDE Application. Enter the name, e.g. helloworld. The default
location will be /home/yourhome/helloworld. If you finished the settings in
this window, click next. In the next window you can set some options which
are preset to useful default values. Click next. Then you are shown the tem-
plate for .h files, and for .cpp files. Again, you can leave them as default, and
click Finish. You will see the message that your program has been created.
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To run your program, select Build - Execute Program. You receive a message
that automake & friends must be run first. Click OK. Your program is built and
executed and a window of your new program pops up, saying "Hello World".
You can now edit your program and add some more useful functionality.
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Chapter 3

Overview of KDevelop
Features

Bernd Pol KDevelop integrates a lot of tools, scripts, and templates in a com-
mon user interface. Basically it consists of

e several user interface modes from which you can select the look and feel of
the workspace,

e an Application Wizard which aids you in setting up a new project,

e several project management systems which aid in building and managing
your project,

e some editing tools to easily work on your program texts
e various file browsers providing you different views on your file system,

e various class browsers to aid you in maintaining the classes and their rela-
tionships of your object-oriented programming project,

e a debugger interface to find and remove program errors from within KDe-
velop, and

e several plugin tools, extensible modules which can be loaded at runtime and
on demand. This allows you to only turn on those features you really need.

e a set of other diagnosis, documentation, and optimization helper tools.
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NOTE
In fact there are three KDevelop-based applications:

e The KDevelop IDE — this is the place where you will usually work.

e The stand-alone KDevelop Assistant documentation browser — isolates all the
powerful documentation facilities of the KDevelop IDE in a separate tool. This
comes in handy when you want to look up some programming documentation
but do not want to start the full IDE.

e The KDevelop Designer — enhances the Qt™ User Interface Designer by KDE
specific elements and integrates nicely in the KDevelop IDE.

3.1 Available User Interface Modes

KDevelop offers developers four separate user interface modes (click on the
mode name to view an example):

e IDEAI
This is a novel user interface approach optimizing both work space and in-
tuitive handling of the tools.

— All tool views are docked in a tabbar fashion around the mainframe area.
They are grouped left, bottom, and right according to the services pro-

vided.
- Editor and browser views will be stacked in a big sized tabbed window
inmidst the mainframe area.

e Child Frame Windows

— All tool views are initially docked to the mainframe.

- Editor and browser views will live like toplevel windows within a view
area of the mainframe.

e Tabbed Pages
— All tool views are initially docked to the mainframe.
— Editor and browser views will be stacked in a tabbed window.

e Toplevel Windows

— All editor, browser, and tool views will be toplevel windows directly on
the desktop.

— The main widget only contains the menu, toolbars, and statusbar.

10
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3.1.1 How to Switch User Interface Modes

To switch the user interface mode select Settings — Configure KDevelop... from
the menus. The Customize KDevelop dialog will pop up, where you have to
select User Interface in the left hand tree. This will display the settings page
shown below.

'v. S0 guraNkavalop

- General User Interface
- Plugins

- Source Formatter
- New File Wizard

— Major User-Interface Mode

\®) IDEAI window mode

- Editor ) Childframe window mode
- Abbreviations
"
- Tools Menu () Tabbed pages mode
- External Tools () Toplevel window mode
- Code Snippets
- File Selector rUse Tabs Use Close On Hover
- Documentation Tree &) Always &) No
\CJ) When more than one ) Yes
) Mever ) Yes, Delayed

—Toolview Tab Layout

) lcons
=) Text
)T

() Text and lcons

Note: Changes will take effect after KDevelop is restarted

Cancel

Select a user interface mode
(Older KDevelop versions provide the top mode selection section only.)

In the Major User-Interface Mode section select the radio button of the user
interface mode you want to work in.

Dependent on the user interface mode you selected, other configuration sec-
tions will become available where you can taylor more details of the look and
feel to your preferences. See the Selecting the User Interface chapter for more
detail.

NOTE
Do not forget to restart KDevelop in order to let your selections take effect.

11
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3.1.2 How to Maximize the Work Space Area

To maximize space, there is a full-screen window mode available which ex-
pands the mainframe area to the screen borders. Additional space can be re-
claimed by hiding the menubar. And you can of course hide any toolbar as
usual in KDE applications.

Full Screen Mode To switch to or from full screen mode select View — Full-
Screen Mode from the menus or press Ctrl-Shift-F. There is also a Full-

Screen Mode icon in the Browse Toolbar available.

Hide/Unhide the Menubar To hide the menubar select Settings — Show Menubar
from the menus or press Ctrl-M. You may also include a Show Menubar
icon in a suiting toolbar, e.g. the Browse Toolbar for that purpose. To un-
hide the menubar you must press Ctrl-M or use the Show Menubar icon
if available.

3.2 Elements of the User Interface

(... to be written ...)

3.2.1 The Workarea

(... to be written ...)

3.2.2 The KDevelop Titlebar

(... to be written ...)

3.2.3 The KDevelop Statusbar

(... to be written ...)

3.2.4 The menubar

(... to be written ...)

3.2.5 The Toolbars

(... to be written ...)

12



KDevelop User Manual

3.2.6 The Tree Tool Views

(... to be written ...)

3.2.7 The Output Tool Views

(... to be written ...)

3.3 Project Management Systems

Globally, a project will rely on some form of project management system. KDe-
velop offers four project management systems the programmer can select from
when creating a new project.

e Automake projects use the GNU standard development tools.
o QMake projects use the trolltech QMake project manager.
e ANT projects use the Apache ANT project manager for Java™ development.

e Custom projects require you to maintain your own Makefiles.

3.3.1 Automake Projects

Projects created with KDevelop’s Automake Manager make it very easy for
developers to use the GNU standard development tools. They provide

o abetter way of Makefile generation and

¢ agood and safe way for fast adaption towards different systems by autoconf-
generated configure scripts.

3.3.2 QMake Projects

For developers who enjoy the flexibility and feel of Qt™"s qmake system, KDe-
velop offers the ability to handle qmake based projects (.pro files) within the
GUL

For more information on the QMake project manager see the ‘qmake User
Guide” which should be included in your distribution or have a look at the
TROLLTECH Documentation home page where you may find the QMake doc-
umentation of your ‘Qt C++ GUI Application Development Toolkit” version.
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3.3.3 ANT Projects (Java™ Projects)

Java™ developers may want to use the Apache ANT project manager for
their projects. To set up a new Ant project in KDevelop select Project — New
Project... — Java — Ant Project — Application.

For more information see The Apache Ant Project home page.

3.3.4 Custom Projects

If you prefer to maintain your own Makefiles for your project you may use the
custom project option of KDevelop. This may be feasible in unusually struc-
tured projects or if you want to retain full control over the make process.

Yet, if you do not really need the extra flexibility and control of the custom
project manager you should consider Automake Manager or one of the other
project managers, because they considerably ease the program building and
distribution processes.

3.3.5 How to Distribute Your Application

The distribution of your applications does not require the end-user to have
anything different installed other than

e an appropriate compiler,
e alinker, and

e the appropriate development libraries,

which at least for C++ applications is most often the case. But you can as well
distribute binary packages of your application. In either way, the end-user of
your product does not need KDevelop installed.

For giving away your sources, we advise to include the project file of KDe-
velop as well. This makes it very easy for other developers—if they use KDe-
velop—to work with your sources.

For projects where several developers, maybe working on different places, are
involved, this should be the case anyway. So you can ensure consistency of the
Makefiles to not run into trouble.

Especially on multi language applications, translators won’t actually work with
the source code, except in cases that require correction for enabling translation
support.
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Chapter 4

Configuring KDevelop

Bernd Pol KDevelop is a very powerful and flexible IDE which offers many
ways to tailor it to your needs. To start configuration select Settings — Configure
KDevelop.... This will cause the configuration dialog to pop up consisting of
a selection window to the left and the configuration dialog on the right hand
side whose contents will vary upon the configuration item you did select.

----- ‘General ||| General
- Plugins

E----Snurce Formatter
- User Interface

| Load last proje

. Editor Default projects di
é----ﬂl:bl:breviatinns /home/devel/proje
- Tools Menu

--External Tools — Message Outpu

E----Cnde Snippets
- File Selector
- Documentation Tree X Line wrappin

Window font; 8

Select a configuration item

We will discuss these configurations in a different order, split up into the main
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topics of General Configuration, Configuring the Documentation, and Advanced
Configuration which makes for a more intuitive reading.

If you want directly look up a certain configuration item use one of the follow-
ing links.
General
Plugins
Source Formatter
New File Wizard
User Interface
Editor
Abbreviations
Tools Menu
External Tools
Documentation
Code Snippets
File Selector

4.1 General Configuration

General configuration concerns the more common tasks of tailoring KDevelop
as there are:

o General Setup
o Selecting the User Interface

e SOURCE EDIT TASKS

— Selecting an Editor
— Selecting a Source Format Style
— Setting Up the Code Snippets Tool

e Configuring the File Selector

4.1.1 General Setup

The General configuration dialog allows you to define some basic KDevelop
behaviour which seldom will change in everyday work. This concerns:

General project options such as

o defining a default parent directory KDevelop shall use for new projects.

o deciding whether you want KDevelop to automatically load the project
you last worked on.

16
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Selecting a font for the most commonly used output view windows, namely:

o the Messages Output View KDevelop uses to communicate e.g. com-
pilation progresses, and

o the Application Output View which will show error and state informa-
tion concerning a running application.

Some common behaviour concerning the displayed lines in the Messages Output View window, namely:

o whether long lines will wrap around, and
e if directory entry and exit messages issued by make will be shown.

The level of detail of messages concerning the compilation process shown
in the Messages Output View window.

General

[®¥| Load last project on startup

Default projects directory:

|fhame,.’devel,.fpmje cts/ ng

— Message Qutput View

Window font: \ Luxi Sans J

[¥| Line wrapping Compiler Output

|| Directary navigation messages & Very short

— Application Output View

Window font: Luxi Sans

The general configuration dialog

Load last project on startup Mark this checkbox if you want to continue to
work with the last project you worked on. This will cause KDevelop
to automatically load this project on start-up. It will usually be shown in
the state you left work so you can readily proceed.

Default projects directory: By default, KDevelop uses a common parent di-
rectory for all new projects. Enter the absolute path of this common di-
rectory in the box or select it from your directory structure. KDevelop
will place the any new project here as a subdirectory.
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NOTE
You may of course change the directory path of a new project at the time you
set it up in the Application Wizard.

Window font: To select a font suitable for the Messages Output View window
click the Window Font button showing the currently selected font (it says
‘Luxi Sans’ in the above illustration). The KDE standard Select Font dia-
log will pop up from which you may select the font to be used.

NOTE

On first start-up, KDevelop initializes this font setting to the standard font for
which your KDE user has been configured. This setting is fixed, so if you alter
Preferences — Appearances & Themes — Fonts in the Control Center, this
will not effect this KDevelop font selection. You will have to explicitly reselect
the Messages Output View window font.

Line wrapping By default, KDevelop will wrap long lines around in the Mes-
sages Output View window so that valuable information will not be eas-
ily overlooked. In some cases this will clutter long message lists. Remove
the checkbox mark if you do not want the lines wrap around.

TiP

There is an alternative way to switch the line wrapping. Just right mouse
button click in the Messages Output View window and mark/unmark the Line
Wrapping entry in the menu which will pop up.

Directory navigation messages The make tool usually will display messages
like “Entering directory’, or ‘Leaving directory” when it switches the di-
rectories it currently works in. As this clutters the messages list in the
Messages Output View window, KDevelop suppresses those messages
by default. Mark the checkbox if you want to protocol which directories
make worked in.

NOTE

Changes in this setting effect the processing of new messages only. Old di-
rectory navigation messages will be kept visible when you switch this feature
off.

Compiler Output KDevelop preprocesses the messages the Messages Output
View window receives during the build processes in order to filter su-
perfluous information. You can control the level of detail KDevelop will
display using the radio buttons in this field.

Very Short Displays only warnings, errors, and the filenames which are
compiled.
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Short Suppresses all compiler flags and formats the output to be more
readable.

Full Displays all output messages unmodified.

Tip

There is an alternative way to switch the compiler output detail. Just right
click in the Messages Output View window and select the according detalil
level from the popup menu.

Application Output View Window font: The Application Output View win-
dow is used to display error and state information from applications
which are run from inside KDevelop. These are information the applica-
tions usually sends to the console when run stand-alone. So you do not

need to leave the IDE when testing the application you currently work
on.

To select a font suitable for the Application Output View window click
the Window Font button showing the currently selected font (it says ‘Luxi
Sans’ in the above illustration). The KDE standard Select Font dialog will
pop up from which you may select the font to be used.

NOTE

On first start-up, KDevelop initializes this font setting to the standard font for
which your KDE user has been configured. This setting is fixed, so if you alter
Preferences — Appearances & Themes — Fonts in the Control Center, this
will not effect this KDevelop font selection. You will have to explicitly reselect
the Application Output View window font.

4.1.2 Selecting the User Interface

As already said in the Available User Interface Modes chapter there are four
different ways the KDevelop work area may be set up, namely:

e IDEAI Mode
e Child Frame Windows Mode
e Tabbed Pages Mode

e Toplevel Windows Mode
To switch the user interface mode select Settings — Configure KDevelop... from
the menus. The Customize KDevelop dialog will pop up, where you have to

select User Interface in the left hand tree. This will display the following set-
tings dialog to the right.
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User Interface

— Major User-Interface Mode

iy |DEAI window mode
iy Childframe window mode
) Tabbed pages mode

" Toplevel window mode

—Lise Tabs Use Close On Hover
iy Always ™) Mo
") When more than one il Yes
) Never ) Yes, Delayed

—Toolview Tab Layout
U lcons

ext

|:_'-‘\

T
) Text and lcons

Mote: Changes will take effect after KDevelop is restarted

Select a user interface mode

Select the radio button of the user interface mode you want to switch to, then
click OK.

NOTE
Do not forget to restart KDevelop in order to let any of these selections take effect.

When you selected either the IDEAl window mode or the Tabbed pages mode
two more configuration sections will become available: Use Tabs and Use Close
On Hover. These allow to configure under which circumstances tabs will be
shown on top of the document windows and whether you may close the doc-
ument by a click on the tab icon.

In IDEAI window mode only yet another configuration section will be avail-
able, Toolview Tab Layout which effectively allows to select between different
sizes of the toolview tabs which surround the main working area in this mode.

Configuring the Documents Tab Bar Display In the IDEAI and tabbed pages
modes there will be named tabs on top of the document windows by de-
fault, so you can easily select different documents with a left mouse but-
ton click. If you prefer to provide more space for the document windows
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in the KDevelop main work area, you may change to another behaviour
in the Use Tabs configuration section.

Always This is the default — show a tab comprising an icon and the
document name on top of any document window in the KDevelop
main area display.

When more than one Do not show a tab when only one document is dis-
played. If there is more than one document, however, KDevelop will
display an according tab bar as in the Always selection above. You
may want to select this mode if you work on a single document most
of the time as this provides more vertical space.

Never Never show any document selection tab. You may prefer this
mode if you seldom use the mouse to switch between documents.
It provides more vertical space for all document windows. To select
another the document window or to close any, use the KDevelop
Window menu.

Setting Up to Close a Document by a Click On Its Tab When you configured
KDevelop to display the documents tab bar, either always or when more
than one document is displayed in the main work area, you may add
more functionality to the tabs beyond their document selection capabil-
ity. Use the Use Close On Hover configuration section for this.

No This is standard behaviour. No extra functionality is added to the
tabs. They may be used only to select document windows on left
mouse button clicks.

Yes When you selected this radio button, KDevelop will allow to close a
document window by a left mouse button click. Use the mouse to
point at the small icon on the on the left tab border. It will change
to a close symbol. Now click with the left mouse button on this
changed symbol and KDevelop will close the according document
window.

Yes, Delayed After selecting this radio button, KDevelop will allow to

close a document window as shown in the Yes case above. The icon
will not change instantly, however, but there will be a short delay

before the close icon shows up.

Configuring the Toolview Tab Layout The Toolview Tab Layout configuration
section will be available in IDEAl mode only. Use these radio buttons to
set up the look of the toolview tabs which surround the main working
area in this mode.

Icons Each tab will show an icon only. If the associated toolview is dis-

played, the tab will open and a descriptive text for this toolview be
shown. You may want to use this mode if you work on a monitor
with limited resolution.
The icons are not very descriptive, however. If you want to find
out which toolview is assigned to a given tab, point at it with the
mouse and wait a second. A short tooltip will then pop up with the
toolview name.
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Text This is the default toolview tab display mode. Each tab displays the
name of its associated toolwiew.

Text and Icons If the standard text toolview display looks too flat to you
and you are working on a high-resolution monitor you may want

to select this radio button. It will cause the name of the associated
toolview be displayed on each tab plus an icon to the left of it, mak-

ing the tabs easier to distinguish. See the Folded Toolview Tabs il-
lustration below for an example.

Folded Toolview Tabs If you selected the IDEAl mode toolview tabs to dis-
play texts (with or without accompanying icons) you need not worry
about them being hidden behind some toolview window. If one of the
bottom toolview windows occupies more space than is available to dis-
play all (vertical) tabs, they will fold around as this illustration shows:

+]

sabeue ayewony (o)

uopeIuawnIog C,, sladdius apod .

4
verlap

Toolview tabs fold to not be hidden behind another view window
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NOTE

The active toolview window must be shown fixed (non-overlap mode), shar-
ing the work area with the other windows, to force such tab folding. Press
the small square in the window border to accomplish this as shown in the
example.

4.1.3 Selecting an Editor

KDevelop allows you to select your favorite text editor tool. Mark the Editor
entry in the left hand side selections tree of the Configure KDevelop window.
The following dialog will be displayed to the right.

Editor

Embedded Editaor

Embedded Advanced Text Editor I
\ J

{Embedded Advanced Text Editor
Embedded Vim Component
Ot Designer Based Text Editor

Select an editor

To select a new editor, click on the arrow on the drop down list field. Depend-
ing on the editor parts interfaces your KDE version has compiled in you will
be provided with a list of editors you may select from (see the Important note
below for this). Click on the editor of your liking and click OK. Currently there
are tree possibilities:

Embedded Advanced Text Editor This is the KDE standard Kate editor part.

Embedded Vim Component This provides the look and feel of the base Linux®
vi editor.

NOTE

e You need to have a suitable Vim application installed. Have a look at the
KVim website for more information.

e Furthermore you need to configure the KParts Vim component in the KDE
Control Center (KDE Components — Vim Component Configuration) be-
fore you can use it.

Qt Designer Based Text Editor Thisis the editor Qt™ provides in its Designer
component.
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These editor interfaces are fully integrated in the KDevelop IDE concept. Par-
ticularly the possibility to jump to the offending source code line by just click-
ing on an error message in the Messages Output View window has been pro-
vided.

NOTE

Changing the editor will not effect already open files. There are two possibilities to
proceed. Either close all open text windows and reopen them one by one. Or simply
close the whole project and reopen it again. The windows will then automatically
open under the new text editor interface.

IMPORTANT

KDevelop lets you use editor interfaces which have registered with KDE and that
provide a KatePart interface. If you miss one one of the selections shown above
check your KDE installation if the corresponding KPart was correctly installed.

4.1.4 Selecting a Source Format Style

KDevelop automatically formats a source text in a predefined style. This style
is highly configurable.

NOTE

The reformat source feature is currently available for C, C++, and Java™ only.
Especially you cannot use it for scripting languages like e.g. PHP. This is because
KDevelop uses the astyle application to implement this feature.

To set up a specific format style, select Settings — Configure KDevelop... from
the menubar. The Customize KDevelop dialog will pop up, where you have
to select Source Formatter in the left hand tree. This will display a series of
three settings dialog tabs to the right, namely a General Formatting Setup, a
Indentation Style Setup, and a Other Formatting Setup.

TP

Any style changes apply to newly entered text only. If you want to change the
formatting style of an already existing source text you will have to explicitly use the
Edit — Reformat Source command.
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NOTE

The exact outcome of these style formatting definitions depends on the editor you
use. Currently, most settings are tailored to the Kate editor part (the ‘Embedded
Advanced Text Editor’). Some other editors (e.g. the Qt editor) may rely on their
own configuration settings. You will have to experiment in this case to find out the
exact effects of the style settings provided here.

WARNING

There may be incompatibilities between the configuration style settings provided
here and the editor you use up to the extent that in extreme cases it even might
destroy your files. Make sure you have a backup of your source files before you try
out these settings with an none KDE standard editor.

4.1.4.1 General Formatting Setup

The General tab of the Source Formatter dialog allows you to select one out of
five predefined source format styles.

Source Formatter

[ General | ‘ ]
— Style —Example
) User defined namespace foospace
J ANSI {
int Foo()
{_J Kernighan & Ritchie I
) Linux if (isBar) {
bar();
) GNU return 1,
) JAVA 1 else
return O,
}
}

Source format style general setup
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A formatted source example will be displayed in the field to the right. If none
of the predefined styles is to your liking, you may click the top User defined
radio button and define your own source formatting style preferences on the
other two tabs which will become available then.

NOTE

Currently only the predefined source formatting styles will be demonstrated by an
example text. If you decide to define your own style, no example display will be

available. You have to experiment on an actual source text to tailor the settings to
your liking.

4.1.4.2 Indentation Style Setup

Proper indentation is the main means to enhance readability of a source text.
I you selected the Indentation tab of the Source Formatter dialog you will be

presented with a series of indentation formatting choices grouped into three
boxes as following.

Source Formatter

General | Indentation | Other

— FEilling Continuation
) Use tabs Maximum in statement: (40 -
) Use spaces: 2 = Minimum in conditional: |Twice current &

— Indented Entities

|| Indent switches
Indent cases

Indent classes

I

(

|| Indent brackets
|®| Indent namespaces
X

Indent |abels

Source format indentation style setup

Default Settings The preset format choices will cause the source text to resem-
ble the ANSI formatting style:

namespace foospace

{
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int Foo ()
{
if (isBar)
{
bar () ;
return 1;
}
else
return O0;

Defining Indentation Width and Characters The radio buttons grouped in the
Filling group define how indents in the source text will be drawn.

Use tabs This will cause the editor to insert a tab character for each in-
dentation level. The tab width is predefined in the editor settings (8

or 4 character columns usually). Use Settings — Configure Editor...
to redefine it.

NOTE

The actual tab width definition procedure depends on the editor you
selected in the Selecting an Editor configuration step. You will have to
look up the corresponding editor help to find out.

Use spaces If you select this radio button, the editor will enter a number
of spaces for each indentation level. Change the number from the
default 2 to the indentation width you prefer.

Indented Entities This defines which of the (C/C++) entities will be formatted
with an extra indent beyond the current indentation level.

By default only namespaces and labels will be extra indented. You may
want to experiment with various settings to tailor those extra indents to
your liking.

Continuation The settings grouped here apply to those cases where the source
formatter automatically wraps around long source lines. It takes two spe-
cial cases in account, namely that in deeply nested indents there should
remain enough room for the source and that conditionals should get extra
indent levels on continuation to make them stand out properly.

NOTE

This applies to static word wrap cases only where a fixed maximum line width
is used in the source text. If you set up your editor to dynamically wrap around
long lines in display only (which is possible in the Kate editor part) the effects
of these settings usually will not show.
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Maximum in statement This setting limits the maximum possible inden-

tation for the continuation lines so that enough space will remain to
keep the text readable. No continuation line will ever be indented
beyond the number of columns you selected in this field.

The default is set to 40 character columns (half a standard 80 column
page). You may want to increase this value to account for wider pa-
per (e.g if you use landscape printing for your sources). Or decrease
the value accordingly to take larger margin settings of your print-
outs into account.

Minimum in conditional Conditionals or source following e.g. an as-

4.1.4.3

signment operator should usually get an extra indent on continua-
tion lines in order to keep the text readable. The amount of this extra
indent is defined here.

The default is set to “Twice current’ which means that continued con-
ditionals will get an extra indent level of the standard indentation

size you selected in the Filling group. You may change this extra
indent to another fixed width (including zero) using the arrows or
by entering the value directly.

Other Formatting Setup

Source Formatter

General |I_ndenration |Q‘fher ]

—Brackets
=) Break
) Attach

) Linux style

—Padding
|| Add spaces around parentheses

| Add spaces around operators

— One Liners

| Keep one-line statements

| Keep one-line blocks

Other source format style settings

Controlling the position of braces The radio buttons the (somewhat misnamed)
Brackets group control the position of block delimiting braces ina (C/C++)
source text. There are three possibilities from which you can select.
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Break This inserts a line break before each opening brace. Both delimit-

ing braces of any block will be put at the same indentation level as
the block head statement.

namespace foospace
{
int Foo ()
{
if (isBar)
{
bar () ;
return 1;
}
else
return 0;

}

Attach This will keep the opening brace of a block in line with the block
head statement. Closing braces will be on the same indentation level
as the block head statement. The else of an if statement will be kept
in line with the closing brace of the preceding block.

namespace foospace {
int Foo () {
if (isBar) {
bar () ;
return 1;
} else
return 0;

}

Linux Style This is a compromise of the above listed styles. Functional
block delimiting braces will be put on extra lines. Braces opening a
block in a conditional or loop statement will be kept in line.
namespace foospace
{
int Foo ()
{
if (isBar) {
bar ();
return 1;
} else
return 0;

Controlling Extra Spaces

By default KDevelop does minimize the use of spaces
in source texts.
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if (isBar (fooArg)==barValue)

You may enhance readability if you force the source formatter to insert
extra spaces in special positions.

Add spaces around parentheses In fact what is meant is to add spaces
around the text put in parentheses. This enhances the readability of
function arguments and conditionals.

if ( isBar( fooArg )==barValue )

Add spaces around operators This will put spaces around assignment
and comparison operators to enhance the readability.

if (isBar (fooArg) == barValue)

Controlling the formatting of one-line constructs There are a few cases where
you don’t want the source formatter to split a long line apart. For C/C++
code this can be controlled here.

Keep one-line statements This keeps single line statements together in
some situations even if they exceed a fixed maximum line length.

Keep one-line blocks This keeps single line blocks together in some sit-
uations even if they exceed a fixed maximum line length.

4.1.5 Setting Up the Code Snippets Tool

When editing in KDevelop you can store often used parts of code as Code
Snippets. To configure the capabilities of the code snippets part select Settings
— Configure KDevelop... from the menubar. The Customize KDevelop dialog
will pop up, where you have to select Code Snippets in the left hand tree. This
will show the following dialog in the right hand side.

Code Snippets

—Tooltips |
[®| Show snippet's text in tooltip

—Variables

Delimiter |$

Input method for variables

) Single dialog for each variable within a snippet

) One dialog for all variables within a snippet

Configuring the Code Snippets tool
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Activate Snippet Preview Mark the Show snippet’s text in tooltip checkbox if
you want to view the stored text in a tooltip window whenever you keep
the mouse cursor over the title of that snippet.

Working with Snippet Variables The Code Snippets tool allows for a variable
text in predefined places any time you insert a snippet into a file. To
accomplish this Code Snippets provides its own variables” mechanism.
You can set up its behaviour in the Variables group.

Delimiter The Code Snippets tool distinguishes variables in the text by
surrounding the variable name with special delimiter symbols. To
use your own delimiter symbol, change the predefined $ character
in the Delimiter field.

Input method for variables
e Single dialog for each variable within a snippet — will in turn pop
up a separate dialog for each variable which the tool finds when
inserting the selected code snippet.

¢ One dialog for all variables within a snippet — will pop up a com-
mon dialog where the user has to fill in the values of all variables
before the snippet will be inserted

4.1.6 Configuring the File Selector

KDevelop provides a File Selector plugin which, when loaded at start-up, al-
lows to navigate to any file or directory in the system.
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O
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y hi16-app-myapp.png|+ README

T |**) hi32-app-myapp.png| | test.cpp

£ . main.cpp test.cpp~
%) Makefile, am

w7 | ) myapp_client.cpp

myapp.cpp

myapp.desktop
. myapp.h

Sy [ myappiface.h

myapp.lsm

leh =) myappui.rc

| myappview.cpp

| myappview.h

|
4|

The file selector (IDEAI mode)

The behaviour of the File Selector can be highly configured. Select Settings
— Configure KDevelop... from the menubar. The Customize KDevelop dialog
will pop up, where you have to select File Selector in the left hand tree. This
will show the following dialog in the right hand side.
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File Selector

—Toolbar

Available actions: Selected actions:

() Reload & Parent Folder

5 New Folder... (JBack

x| Delete &J Forward
) Home Folder
] Short wiew
] Detailed view
.7 Bookmarks

I Current Document Directory

—Auto Synchronization

"] When a document becomes active
] When a document is opened

|| when the file selector becomes visible

Remember locations: |o =
Remember filters: |o =
Session

|| Restore location

|| Restore |ast filter

Configuring the file selector

Configuring the Toolbar There is a toolbar on top of the File Selector which
can be configured as usual in the Toolbar group.

1. Select an item in the right hand Selected actions list after which the
new action should be inserted.

2. Select the action to be inserted in the left hand Available actions list.

3. Click the right (upper) arrow between both lists. The action will

be removed from the Available actions list and inserted into the Se-
lected actions list below the selected item.

1. Select the item to be removed in the right hand Selected actions list.

2. Click the left (lower) arrow between both lists. The selected item
will be removed from the Selected actions list and put back into the
Available actions list.

1. Select the action to be moved in the right hand Selected actions list.

2. Click the up or down arrow to the right of this list. The selected item
will be moved up or down the Selected actions list.

Defining When the Contents Should Change Updating the contents in the File
Selector window takes time and resources, esp. when changing to an-
other directory. Therefore File Selector is set up by default in such a way
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that its contents change only on demand, i.e. when you select another
directory or when you explicitly want to refresh its contents.

NOTE

Click the Reload button in the toolbar to update the contents of the File Selec-
tor. This toolbar button is not available by default, however. You must insert it
there first.

You can configure the File Selector to immediately reflect certain changes
in your work. The settings in the Auto Synchronization group of the
configuration dialog are responsible for this.

When a document becomes active If you select this checkbox, the con-
tents in the File Selector window will be updated whenever you go
to another already open document, e.g. when you click on the tab
of the according edit window in IDEAI mode. If necessary the File
Selector will switch to the directory this file belongs to and update
the display to show the actual contents in there.

When a document is opened If you select this checkbox, the contents in
the File Selector window will be updated whenever a document will
be opened, e.g. by the File — Open menu. If necessary the File Se-
lector will switch to the directory this file belongs to and update the
display to show the actual contents in there.

When the file selector becomes visible If you select this checkbox, the
contents in the File Selector window will be updated whenever it
gets visible again. If necessary it will switch to the directory the ac-
tual document belongs to and update the display to show the actual
contents in there.

You may freely combine these settings to tailor the actualization behaviour
of the File Selector to your liking.

Controlling the History in the Comboboxes There are two comboboxes on top

and bottom of the File Selector contents window which control the direc-
tory to be displayed (top combobox) and the filters to be applied to the

file display (bottom combobox). A history of the most recent settings is
kept in the selection field of each combobox. You can configure the num-
ber of history entries as follows.

Remember locations Enter here the maximum number of directory se-
lections the upper combobox shall remember.

Remember filters Enter here the maximum number of filter definitions
the lower combobox shall remember.

Controlling What Should be Remembered Between Sessions By default
the File Selector is set up so that it shows the display of the most re-
cent session again at the next KDevelop start-up. You may change
this behaviour in the Session configuration group.
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NOTE

If KDevelop was automatically restarted by the KDE session manager
the changes in these settings will have no effect. In this case loca-
tion and filter settings of the most recent KDE session will always be
restored.

Restore location Remove the checkbox mark here if you don’t want the
displayed location be remembered between sessions.

NOTE

If you selected one of the automatic update settings the displayed loca-
tion might automatically change regardless what has been remembered
from the recent session.

Restore filters Remove the checkbox mark here if you don’t want the
filters applied to the display be remembered between sessions.

4.1.7 Configuring the New File Wizard

(... to be written ...)

4.2 Configuring the Documentation

KDevelop contains a very powerful documentation facility which provides ac-
cess to several kinds of extensive documentation. In e.g. IDEAl mode you find
a Documentation tab at the right border of the work area.
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Finder

Search

Bookmarks

The KDevelop documentation window (IDEAI mode)

NOTE
KDevelop must have loaded the Documentation plugin in order to view the docu-
mentation tree. See the Plugin Tools section for more info.

You may set up contents and behaviour of the various parts of this documenta-
tion window if you select Settings — Configure KDevelop... from the menubar.
The Customize KDevelop dialog will pop up, where you have to select Docu-
mentation in the left hand window.

The thus displayed configuration page shows three tabbed configuration dia-
log pages, namely:

Documentation Collections
Full Text Search
Other
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4.2.1 Setting Up Documentation Collections

The documentation configuration settings have been divided into a series of
documentation collections, each providing access to documentation files of
some unique format and content type. These setups control which documenta-
tion items will be listed on the Contents page of the KDevelop Documentation
facility, and how the user may access documentation details by indexed and
full text searches.

The Documentation tab provides a series of configuration pages which are or-
dered vertically like a stack of index cards. One page at a time will open after
a click on its index card title:

Qt Documentation Collection

CHM Documentation Collection

Doxygen Documentation Collection
KDevelop TOC Documentation Collection
Devhelp Documentation Collection
Custom Documentation Collection

Documentation

[Qccumentaﬁcn Collections |FuIIText§earch |Oﬂ1er ]

Qt Documentation Collection | Add |
TOC |Index |Search |Title * _

O O O gmake User Guide i Edic |
5| 5| 5| (Qt Reference Documentation R

| O O Ot Designer Manual = R, 3
| O O Ot Assistant Manual

O O O Guide to the Qt Translation Tools

[ 1|

CHM Documentation Collection

Doxygen Documentation Collection

kKDevelopTOC Documentation Collection

Devhelp Documentation Collection

Custom Documentation Collection

Setting up documentation collections
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4211 Common Documentation Setup Structure

All configurations pages on the Documentation tab use a common layout. You
will find the currently available documentation items of this type listed on the
open page to the left and a set of buttons to the right.

Buttons to Maintain Documentation List Contents There are three buttons avail-
able to maintain the contents of the documentation setup pages:

Add Opens a Documentation Catalog Properties dialog as shown below
where you can select the source location of the documentation item
to be added and name it.

Edit Opens a Documentation Catalog Properties dialog as shown below
where you can change the source location of the documentation item
previously selected in the list and rename it.

Remove Removes the selected documentation entry from the list.

NOTE

The entry will be removed from the list only. Actual documentation
sources remain untouched. You will have to remove them explicitly by
other means.

= o

-

Location:

ﬂ QK h Cancel |

Add or change a documentation item

Y

The button to the right of the Location field opens a directory dialog
whose entries usually will be filtered according to the file type of the
selected configuration page.

The Title field may not be accessible, depending on the documentation
type to be maintained.

Documentation List Structure Every documentation setup page shows the listed
documentation items in a table with four columns:

TOC If this check box is marked, this documentation item will show up
on the Contents page of the KDevelop Documentation facility.
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NOTE

Unchecking the TOC check box will in turn disable the Index and Search
check boxes (see below). Thus you cannot have documentation collec-
tion items indexed but not shown in the contents.

Index If this check box is marked, an internal index will be built of this
documentation item. This provides fast access to the documenta-

tion by the use of the Index and (optionally) Finder pages of the
KDevelop Documentation facility.

NOTE

The internal index will be built the first time the user selects the Index
page. This will delay the first access noticeably, because the index will
be read from disk and then cached.

All subsequent indexed searches will however use this chache and thus
work significantly faster.

Search If this check box is marked, the contents of this documentation
item will be included in the full text search path of the Search page
of the KDevelop Documentation facility.

NOTE

KDevelop utilizes the htdig application collection to perform full text
searches. This search is done over an internal index, the htdig ma-
chinery has to build before it can be used.

Any change of the Search check box marks will thus effect the search
runs only after you rebuilt the index on the Search page of the KDevelop
Documentation facility.

Title This is the name of the Documentation item as it will be shown on
the Contents page of the KDevelop Documentation facility.

NOTE
Former KDevelop versions allowed to select the documentation items to be
displayed on a per-project basis. This is not available any more.

4.2.1.2 Qt™ Documentation Collections

On this configuration page all Qt™ documentation is set up.
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Documentation

[Qccumentaﬁcn Collections |FuIIText§earch |Oﬂ1er ]

Ot Documentation Collection | Add |
TOC | Index |Search |Title * _

(| O O gmake User Guide l—JEdlt
| 5| 5| Ot Reference Documentation R

| O O Ot Designer Manual = | RO g
=] O O Qt Assistant Manual

O O O Guide to the Qt Translation Tools

[

CHM Documentation Collection

Doxygen Documentation Collection

KDevelopTOC Documentation Collection

Devhelp Documentation Collection

Custom Documentation Collection

Setting up the Qt documentation collection

Normally KDevelop will fill this in on its first start-up. It looks for standard *-
.xml, or *.dcf documentation files in the Qt™ installation directory. The table
to the left lists the files KDevelop found by their standard titles.

If you have a non-standard installation, either there will be no information
listed at all or the entries will possibly refer to improper locations (e.g. to an-
other Qt™ installation available in your system). You may adjust the entries
using the buttons to the right of the list field.

NOTE
KDevelop will use the titles already provided by the installed Qt™ documentation.
Hence the Title field in the Documentation Catalog Properties dialog is inaccessible.

By default, not all Qt™ documentation will be shown on the Contents page
of the KDevelop Documentation facility. Use the TOC check box in the setup
table to select the documentation to be shown.

If you want to have some specific Qt™ documentation included in the search
indexes or full text search use the Index and Searchcheck boxes in the setup
table.
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4.21.3 Setting Up the CHM Documentation Collection

On this configuration page you may collect documentation according to the
Microsoft® CHM help file standard.

Documentation

[Qucumentaﬁun Collections |Fu|| Text Search |Gli"|er ]

Ot Documentation Collection \ Add J

CHM Documentation Collection :

TOC |Index | Search |Title | RS
Bemowve

Doxygen Documentation Collection

kKDevelopTOC Documentation Collection

Devhelp Documentation Collection

Custom Documentation Collection

Setting up Microsoft CHM standard documentation files

By default, this configuration page will be empty (as shown above). You may
add new entries using the buttons to the right of the list field. KDevelop will
filter *. chm files in the directory dialog associated to the Add and Edit buttons.

For more information on the format of Microsoft® *.chm files see e.g. PHP:
Documentation - Extended CHM Format at http://de2.php.net/docs-echm.php.

4214 Documentation Generated by Doxygen

On this configuration page all API documentation generated by Doxygen is set
up.
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Documentation

[Qucumentaﬁun Collections 1Fu||'|'ext§earch |Oﬂ1er ]

Ot Documentation Collection Add

CHM Documentation Collection
Edit
Doxygen Documentation Collection L_—J

TOC |Index |Search |Title * Bemowve
5| 5| | The KDE API Reference (The KDE

i

[

-l [ | (o]

KDevelopTOC Documentation Collection

Devhelp Documentation Collection

Custom Documentation Collection

Setting up Doxygen generated API documentation

In short, such an API documents the interface to certain library functions. The
API documentation on this page should be produced by the externally pro-
vided Doxygen tool.

Doxygen generated API documentationconsists of a series of html files, starting
with index.html. Additionally there may exist tag files which contain infor-
mation to link to already existing API documentations. Thus KDevelop will
look for index.html and *.tag files when searching for Doxygen generated
API documentation.

There are some structural constraints assumed when searching for Doxygen
generated API documentation. The directory in which the index.html file re-
sides should contain subdirectories with separate documentation collections.

Each of these subdirectories is assumed to contain a .tag file and a html/ sub-
directory.

You may have a look at $KDEDIR/share/doc/HTML/en/kdelibs-apidocs for an
example of such a Doxygen API documentation layout.
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NOTE

The older KDE KDoc generated API format is not directly supported any more. If
you still want to use such documentation, you may add it on the Custom Documen-
tation Collection page.

KDevelop will have filled in a link to the current KDE Libraries API, provided
it found one. There are several ways for KDevelop to find out:

e Either you provided the configure command with the --with-kdelibsdox-
y-dir option when you compiled KDevelop (see the How to Obtain a KDe-
velop API Documentation chapter).

e Or the configure command did automatically find a Doxygen generated
KDE Libraries API in one of several standard locations it knows of.

e Or as a last resort the SKDEDIR/share/doc/HTML/en/kdelibs-apidocs/ was
found at the first KDevelop startup.

If KDevelop did not find a valid Doxygen generated KDE Libraries API at its
first start-up the Doxygen Documentation Collection list will be empty.

You may add your own API documentation entries (e.g. from your current
projects) by using the buttons to the right. If you want to have them included

in the indexed and/or full text search mark the Index or Search check boxes in
the setup table.

NOTE
KDevelop uses the title information from the index.html. Hence the Title field in
the Documentation Catalog Properties dialog is inaccessible.

43


http://sirtaj.net/projects/kdoc/

KDevelop User Manual

TiP

The KDE system provides more AP| documentation than the KDE Libraries API
only. You will need additional interfaces information if you want to e.g. include the
Kate part into you programs. For this Kate part API for example you should compile
and install the KDE Base Libraries API from the sources (using the make apidox
and make install commands on the kdebase sources) and then add an entry to
the Doxygen Documentation Collection list like this:

3 5. Docu o e Fo Fir

Location:

aloarProne

|a’homefdew’mvkde—5',.rstema'share.FdocfHTI'\-"ILfena’kdebase—apidocsfkatefhrmlfindex.html ng

q QK h Cancel |

4

Adding a KDE Base API to the list
(Of course you should replace the /home/dev/mykde-system/ directory in the

Location field example with the path to your KDE installation.)

NOTE

You must put the API of your current project into this Doxygen Documentation Col-
lection as well. Former KDevelop versions did put it into the documentation tree on
a per-project basis. This is not provided any more.

4.2.1.5 Handling Structured Documentation (KDevelopTOC Files)

The main bulk of the KDevelop documentation facility provides immediate
access to structured documentation, local as well as remote ones. You can con-
figure this on the KDevelopTOC Documentation Collection page.
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Documentation

[Qucumentaﬁun Collections Full Text Search |011’|er 1

Ot Documentation Collection \ Add |
CHM Documentation Collection =
It
Doxygen Documentation Collection l_—J
KDevelopTOC Documentation Collection | Bemowve J
TOC |Index |Search |Title *
O O wxWidgets bugs
| O User Agent Accessibility Guidelineg
O 0O SuperWaba 3.4.1 AP
O O Scalable Vector Graphics (SVG) 1
O 0O STL (sgi.com) —
O 0O SDL -
O O Ruby bugs 1
m [ | = ¥
- [ | (o]
Devhelp Documentation Collection
Custom Documentation Collection

Providing KDevelopTOC structured documentation access

KDevelop comes with a bunch of predefined KDevelopTOC files which are
automatically entered in the table at installation time. To keep the display
manageable only the most often used will initially be marked for display. If
you want to see another documentation, mark the TOC check box in the setup
table.

KDevelopTOC files cannot be indexed to perform a full text search because
they usually point to a remote location. On the other hand, such a . toc file can
have an index manually defined, using the <index> tag. Thus the Index check
box will be enabled ony when KDevelop finds an <index> tag in the .toc file.
(For more detail see the description below in the KDevelop TOC Files section.)

The Search check box in the setup table will always be disabled.

You may add new entries using the buttons to the right of the list field. KDe-
velop will filter *.toc files in the directory dialog associated to the Add and
Edit buttons.

NOTE
Other than former KDevelop versions will the Remove button not change the *.toc
files on disk, so the remove operation is safe now.
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4.2.1.6 KDevelop TOC Files

There is a special feature associated with this. To illustrate, follow these steps:
In the documentation tree find an entry shortly below the Qt™ /KDE docu-
mentation (e.g. ‘KDE2 Development Book (kde.org)’). Click on the plus sign
next to it. A tree will open where you can quickly navigate to subsequent chap-
ters nested several levels deep, all offline. But if you finally select one of the
chapters, KDevelop will in many cases try to access a remote documentation
file.

The rationale behind this is not only to locally navigate remote documenta-
tion without wasting net access resources, but to provide the developer with
easy, structured access to the documentation he/she needs. Using these tools
one can access almost any local or remote documentation in a structured fash-
ion even if the original is laid out flat or structured in another way. All that
is needed is access to files and/or parts of files which are displayable by the
Kongqueror.

Such structured access is made possible through the use of special ‘table of
content’ files, which are denoted by .toc filename extensions. Any such KDe-
velop TOC file contains an XML structured description of the document to be
accessed.

Standard Directory of KDevelop TOC Files When KDevelop was installed usu-
ally a series of predefined .toc files has been put into the $KDEDIR/s-
hare/apps/kdevdocumentation/tocs directory. These are fairly simple,
structured text files. You may look at them using a text editor or other
text display facility.

BASsiC STRUCTURE OF KDEVELOP TOC FILES

<!DOCTYPE kdeveloptoc>

<kdeveloptoc>

(title)

header (base address)

(content structure)

(index structure)

</kdeveloptoc>
This XML structure will be parsed by the KDevelop Documentation plu-
gin to set up the documentation tree contents and to guide the user in
navigating the documentation. It contains all information necessary to
display titles and access the documentation file contents.

title <title> (some title string) </title>

This is the title KDevelop will display at the basic levels in the documen-
tation tree.

NOTE
This displayed title cannot be changed by the user. If you want another text
be displayed, you must manually change the <title> entry in the .toc file.
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base address <base href=" (base document URL) " />

This URL points to the location where all files of this documentation are
located. It will be prepended before each section URL in the following
content structure list. So, if you e.g. downloaded a documentation from
a remote server, all you need to display the files from this new location is
to change its <base> URL.

<tocsectl name=" (section title) " url=" (section URL) ">
content structure <tocsectn name=" (section title) " url=" (section URL) " />

</tocsectl>

All remaining navigation and access information is stored in a series of
nested <tocsecti> ... </tocsecti> pairs. Each i denotes a consecutive
nesting level down to number n which will correspond to the finally dis-
played documentation section.

Any <tocsecti> entry must have a name="xxx" attribute associated with
it (the "xxx" denotes the actual title string). This name will be displayed
as level title in the documentation tree. It should correspond to an actual
documentation section.

There may be an url="" attribute associated with any i nesting level.

When the user clicks on a section title in the documentation tree KDe-
velop will try to access the file at the location pointed to by the combined

base and section URL.

The <tocsectn/> entry must have an url="" attribute whatsoever. This
final nested <tocsectn/> does not come in pairs but will immediately be
closed by a / before the > bracket.

NOTE

Any address combined of base and section URL must point to some dis-
playable text file. Usually this will be an HTML-structured file. It is possible to
link to anchor marks within such an HTML file using the standard # notation
of the format: /base-url/section-url#anchor-mark

<index>
index structure <entry name=" (index entry title) " url=" (index section URL) " />
</index>

Index is a plain list of index entries - pairs of title and URL. Index is not
mandatory.

4.2.1.7 DevHelp Documentation

DevHelp documentation is another means of structured documentation access.
It uses structured table of content files denoted by a . devhelp extension similar
to KDevelop TOC files to access documentation for the GNOME 2 desktop.
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You can control which DevHelp files should be accessible on the DevHelp Doc-
umentation Collection configuration page.

Documentation

[Qucumentaﬁon Collections |Fu|| Text Search |Oﬂ1er ]

Ot Documentation Collection Add
CHM Documentation Collection _
Doxygen Documentation Collection &
KDevelopTOC Documentation Collection Bemove

Devhelp Documentation Collection -
Index |Search |Title *

gtkmm library Reference Manual
The gdk-pixbuf Library

Libbonobo Reference Manual
LibBonoboll APl Reference Manu
GTK+ Reference Manual

GObject Reference Manual
GMNOME Library Reference Manual

] — ] Y

Custom Documentation Collection

[l

[y |

+10000000 4
A
10000000
10000000

Providing DevHelp documentation

DevHelp files originally were accessible on the LiDN website, but this seems
to be not maintained for some time now. More recent DevHelp documentation
is available at the DevHelp Books Download web page.

When KDevelop is installed it will attempt to find all .devhelp files in some
standard places in the system, e.g. in the subdirectories of /opt/gnome/share/.
Initially these files will not be marked for display. If you want to see another
documentation, mark the TOC check box in the setup table.

You may add new entries using the buttons to the right of the list field. KDe-
velop will filter *.toc files in the directory dialog associated to the Add and
Edit buttons.

4.2.1.8 Setting Up Custom Documentation Collections

This is for your own purpose. You may add almost any documentation files
here, provided they can be displayed by the Konqueror plugins.
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Documentation

[Qucumentaﬁon Collections Full Text Search |012|’1EF ]

Ot Documentation Collection Add
CHM Documentation Collection :
Doxygen Documentation Collection &
KDevelopTOC Documentation Collection Bemowve

Devhelp Documentation Collection

Custom Documentation Collection

TOC |Index |Search |Tite
F Custom Documentation Test

Providing custom documentation

Usually this collection will be empty at first KDevelop startup. We have filled

in a deliberate item to show the entry structure.

Handling is straightforward here. Use the buttons to the right of the list field
to add, edit or remove the document items. KDevelop will not filter anything

in the directory dialog associated to the Add and Edit buttons.

You will have to explicitly select the items for display in the KDevelop docu-

mentation facility. Mark the TOC check box of the entry in the setup table.

NOTE

check boxes have no effect here as shown above.

Custom documentation cannot be indexed or searched. Thus the Index and Search

4.2.2 Setting Up Text Search Indexes

(... to be written ...)
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Documentation Tree

General | Full Text Search | Bookmarks | KDevelopTOC Documentation | DevHelp Documentation ]

Index Qt documentation
Index kdelibs documentation generated by Doxygen

Index other books

OOXEDO

Index bookmarks

htdig executable: |fu5r,.’binfhtdig

htmerge executable: |,'u5r,’bin{hrmerge

htsearch executahle: |,’srwvmwfcg i-binfhtsearch

EEEE

Database directory: |fhome,.’deve|f. kde/sharefapps/kdevdoctreeview/helpindex

Update Config Update Index

Setting up text search indexes
4.2.3 Other Documentation Configuration Settings

(... to be written ...)

4.3 Advanced Configuration

(... to be written ...)

4.3.1 Plugin Tools

(... to be written ...)

4.3.2 Abbreviations for the Word Completion

(... to be written ...)
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4.3.3 Adding KDE Standard Applications to the Tools Menu

(... to be written ...)

4.3.4 Adding External Applications to Menus

(... to be written ...)

4.3.4.1 Adding to the Tools Menu

(... to be written ...)

4.3.4.2 Adding to the File Context Menu

(... to be written ...)

4.3.4.3 Adding to the Directory Context Menu

(... to be written ...)
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Chapter 5

Getting Started — the
Application Wizard

Bernd Pol In KDevelop software development work is organized in projects.
Such a project keeps everything together which belongs to a complete pro-
gramming task: source files, additional data files, any actually needed man-
agement facilities as the make system as well as access to all components and
any additional tools needed to get the application up and running.

Organizing all development work in projects allows you to easily switch be-
tween the global tasks at hand. This is quite handy if you e.g. work on several
applications at the same time as is often the case. Tell KDevelop to open the
project you want to work at and you may proceed in the environment just
where you left.

5.1 New Projects

Whenever you want to initiate a new programming project quite a lot of formal
setup procedures need to be done. An initial directory structure has to be set
up, initial header and source files must be provided, the make system has to be
initialized, etc.

KDevelop provides an easy way to initiate a new programming project—the
Application Wizard. You will find the Application Wizard at menu entry Project
— New Project.

Only a short series of steps is necessary to start a new programming project,
using the Application Wizard:

1. Select the programming language you want to use and the type of the
application you want to build from a set of predefined templates.
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2. Supply some general information as application name, directory where
the application shall be built, etc.

3. Decide whether you want to use a version control system, like e.g. CVS,
and supply the necessary data if needed.

4. Set up some templates for initial header and source files (if applicable).

5. Finally tell Application Wizard to set up all initial stuff, directory struc-
ture, starting header/source file templates, and management tools, like
e.g. an initial make skeleton, etc.

Voila—that’s all. Application Wizard will have provided you with a primary

functional set of programming files, where you can readily start working.

Let’s look at all this in more detail now ...

5.1.1 Initial Steps

To create a new project in KDevelop, select New Project from the Project menu.
The Create New Project dialog will pop up showing an initial General page:
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v. = Cragia Now Prorecl Y B
General
+-[EAda *
; C = [rp—— EEE]
i View Heip
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Udm
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+-[EdEmbedded =
--[E3KDE

- Application framework

- Application framework (KParts)
--Control Center module

- ate plugin Fluasy
- K ate plugin with config page

- K Bear Import Filter
- K Bear Plugin

- DE DCOP Service
-~ DE Screen Saver

Generates a simple KDE application with
one toplevel window, menus and
toolbars. A DCOP interface is also
provided, so that your application can

- K File plugin provide a scripting interface
- KHTMLPart plugin
- Kicker Applet

—Properties

Application name: |MvApp

Location: |,.fhome,.'dew..'el,.fpru::njec'rs,.r LEJ
Author: |Your Mame Email: |vou@vuu.com|

Version: |U.l License: l GPL [l J
Final location: fhomefdevel/projects/myapp

| J ﬂ Next = P | Cancel

Initial dialog to set up a new project

As you see, this dialog is divided into an upper and a lower part. In the upper
part you can decide on the programming language and application type, the

lower part holds some general information.

5.1.1.1 Select Programming Language and Application Type

The left hand side of the upper part in this dialog is where you do the selection
work. When it shows up, you'll find there a list of folders each labeled with a

programming language, as there are:

e Ada
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o C
o C++
e Database (SQL Projects)

e Fortran
e Haskell
e Java

e PHP

e Pascal
e Perl

e Python

e Ruby
e Shell (Scripts for the Bash Shell)

To be precise, these folders do not contain real programming tools actually.
They do lead to pre-defined templates you can use as a starting point for de-
velopment in that language. To get an idea of what is provided, just open the
folders one after the other. There will be a series of subfolders on some, one or
more simple entries only on others. The subfolders you see organize the avail-
able templates according to some tasks, the simple entries name the templates
you may select.

We cannot go into detail here on which tasks each template provides, but it’s
easy to find out. Whenever you select a template entry some information is
displayed in the fields to the right. In the lower field you will find a short
description on what the template is supposed to do. In the field above that a
picture will be shown, if available, about the outcome of the application this
template produces if you compile and run it unmodified. Usually this is a
screenshot of the main window the application will display.

Select the template which best fits your application’s goals as a starting point.
Then enter the general properties information in the lower field as shown in
the next chapter.

Selecting a Project Management System Each template is bound to a specific
Project Management System. Currently there is no direct means to freely select
such a Project Management System. You have to find a template which suits
your needs or alter your project accordingly after creation.

5.1.1.2 Provide General Information

The lower part of the Create New Project dialog General page is a framed field
labeled Properties. You must provide some general information about your
project here so that the Application Wizard knows how to build the initial
structure.
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Application Name Your application needs a name of course. Enter this in the
uppermost Properties field, called Application Name. We use ‘MyApp’ as an
example.

When you do so, you will notice that the Application Wizard refuses to accept
special characters of any kind. The only characters accepted are:

e upper and lower case characters

e numbers

e the underline character

One prominent cause of this restriction is that the Application Wizard will use
this application name as the basis of some class names it will construct when it
sets up an initial project. Thus the name of the application must stick to the
rules of the programming language you use.

The Project Directory The other prominent cause of this restriction you can see
at the bottom line of the Properties area. It is labeled Final location and shows
the directory where the Application Wizard will create the application.

As you type the application name you will notice that the Application Wizard
repeats your input at the end of the Final location line, using lower case only
characters.

Thus you must select the name of your new application with care. If you end
up with an already used directory the Application Wizard will not allow you
to continue to the next step, keeping the Next > button deactivated (grayed).
Yet, it will warn you in this case by appending ‘(dir/file already exist)’ to the
Final location line.

The Starting Path There are two ways to select another path for your new
application. One is to select another name. Yet, this is not always feasible (you
might e.g. set up for another version of an already existing application). As an
alternative you may select another path to the application directory.

This is done in the second row input field of the Properties, named Location.
What you enter here is the starting path of the new application development
directory. The Application Wizard appends the application name to this path
when it initializes the new project. The result is shown in the Final location line
to give you better control on what is going on.

Application Wizard will copy an initial value to the Location field on start-up.
This is taken from what you have chosen in the Default projects directory field
during the general configuration steps. In our case we have KDevelop set up
to use /home/devel/projects/ as initial path for new projects.

Alter the Location field contents so that the application development directory
shown in the Final location line will be unique.

NOTE

Take care that the path you enter in the Location field already exists. Otherwise you
will not be able to continue to the next step. The Application Wizard will warn you
about non-existing paths by appending ‘(invalid)’ to the Final location line.
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Personal Information The fields following this are not so critical. Just supply
your name (i.e. the name of the person who is responsible for the application)
in the Author field, and a valid e-mail address in the Email field, so that users
can give you feedback on the application.

NOTE

1. The Application Wizard fills these fields with some default values, taken from
the Email presets in the KDE Control Center. If these defaults in the Create
New Project Author and Email fields do not suit, you may want to have a look
at your mail configuration in the KDE Control Center.

2. The Application Wizard will integrate this information into the starting program
templates if applicable. In KDE C++ programs for instance you will find it near
the beginning of the main. cpp source file.

3. Of all fields, the Email is optional, reflecting the fact that not every developer
may have access to the internet. You may keep this field empty if you wish
and proceed nevertheless.

Version and License Info Finally enter a starting version number for your new
application in the Version field, and select the license under which you want
your application be put from the License tab.

If you select an application type for which the Application Wizard provides
common source template texts (e.g. C/C++), you may view the license notifi-
cation text on the third page of this Create New Project dialog (see the Supply
header/source templates chapter below).

If you selected ‘Custom’ from the License tab you must provide a license text
on your own.

NOTE
Both version and license information will as well be integrated into the starting tem-
plates in a suiting format the application type you selected does provide.

Once you have correctly entered all this information stuff, press the Next >
button to proceed as shown in the following chapters.

5.1.2 Supply Version System Information

In a second step the Application Wizard will lead you to the Version Control

System page where you can decide which version control system you want to
use.
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NOTE
This discussion concentrates on the needs for project creation only. For more infor-
mation on CVS see the Using CVS chapter below.

No Version Control System Wanted Initially there is ‘None” selected in the
Version control system tab, and the page will be empty otherwise. If you don't
want to use a version control system, just click the Next > button and go on.

Using CVS Otherwise you must reselect the version control system you want
to use from the Version control system tab. We use ‘CVS’ for our example. If
you select this, the Application Wizard will redisplay the page, now showing
a series of fields you must fill in.

Version Control System

Version control system:

CVS root: |fhomefdevelfcv5ruor

|| Init root

CVS_RSH: |

CWV5S repository: |MvA|::p

Vendor tag: |vendor
Message: |new project
Release tag: |5tarT

[ < Back J ﬂ Next > F |_ Cancel J

Set new project up for CVS
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A version control system such as CVS (which means ‘Concurrent Versions Sys-
tem’) stores copies of selected project files in some sort of a database. If you use
CVS you can amongst others upload (‘commit’) those files or load them back
into your project directory (‘checkout’, or ‘update’). The special thing about
this is that the files in the versioning database are stored in a structured way
which allows you to always revert to an earlier development state if you need
so. And CVS allows multiple designers to fairly easily collaborate on a big
project (such as KDevelop) without disturbing each others work.

CVS Root CVS needs to manage the versioning database it keeps from your
project files. To accomplish this it keeps some special database information in
an own directory, called the CVS root. The first step on setting up CVS for your
new project thus is to tell KDevelop where this root is located.

Local CVS root. There are two basic possibilities. Either you want to use a local
CVS database or you use a database which is held on a remote server. If you
develop for your own, you may want use the CVS database as some sort of
a backup system on your own computer. Usually this is set up in your home
directory root and given the name cvsroot. This may look as follows:

/home/devel/cvsroot (where devel simply denotes the ‘developing’ user, just
for example)

NOTE

In fact, this is a short form. Exactly, the local CVS root should be addressed using
the :1local: prefix. The short form is only allowed in cases where the filename
starts with a slash (/). The full name for our example local CVS root would exactly
look like: :1ocal:/home/devel/cvsroot

Enter the name of the CVS root directory your system has been set up for in the
CVS root field. In principle you can select any name, even use multiple CVS
databases, but it is advisable that you stick to the CVS root once set up.

Initialize a new CVS root. If there does not exist a CVS root yet, KDevelop can
command the CVS system to create one for you in the given directory. Just
check the Init root checkbox below the CVS root field.

NOTE

As said, KDevelop only commands the CVS system to initialize a new CVS root. It
does nothing by itself to this directory. Fortunately CVS is clever enough to check
whether the CVS root directory already exists. Hence it does no harm if you should
have inadvertently checked Init root on an already existing CVS root directory.

Remote CVS root. There are occasions where the CVS database is to be kept on
a remote server, especially when several developers work at the same project.
Then you must enter the CVS root URL of this server in the CVS root field. For
example, if you want access to the KDE CVS server:
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:pserver:mylogin@cvs.kde.org: /home/kde (where mylogin denotes the lo-
gin name set up in your KDE CVS account)

Remote CVS Server Types Basically there are two widely used remote CVS
server types, the pserver which uses a password-secured non-encrypted proto-
col, and the ext server which uses an rsh or ssh encrypted data transfer. They
are distinguished by the URL prefix they use:

ipserver:

for the ‘password protected server’ non-encrypted type, and

rext:

for an rsh or ssh encrypted server type. For example
rext:mylogin@cvs.cervisia.sourceforge.net:/cvsroot/cervisia

accesses the CVS root of the widely used Cervisia CVS management tool on
the SourceForge server.

If you want to use an rsh or ssh encrypted server for CVS access you must
tell KDevelop the encryption protocol to be used. Just enter rsh or ssh in the
CVS_RSH field of the Create New Project Version Control System page.

NOTE
There is a caveat if you use an encrypted server for CVS from within KDevelop.
See the Using CVS chapter for details.

The CVS Repository So far you have told KDevelop where the CVS root re-
sides which manages the versioning database and how to access it. Now you
need to tell KDevelop under which name you want CVS save your project files
in that database. Such a place your project files will be held in CVS is called a
repository.

In principle you can use any name for the CVS repository of your project files
as long as it adheres to the specifications of naming a file. Yet, most develop-
ers simply use the name of the application itself. CVS will build a directory
with this name in the CVS root, hence it is more easily found if you keep the
application name for it.

Just enter the repository name you want to use in the CVS repository field of
the Create New Project Version Control System page. In our example this is:
MyApp

WARNING

Take care not to use a repository which already exists! The CVS system does not
warn about duplicate files but will shovel everything in which does not produce a
formal conflict. You will mess up everything!

The Remaining Fields There is not much work left to do. Application Wizard
has already set up the remaining fields for you. In detail:
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The Vendor field is used for compatibility reasons only. You can stick to the
‘vendor’ default the Application Wizard puts in here.

The Message field allows you to comment the initial CVS contents. Use any
text you like or just stick to the ‘new project’ default the Application Wizard
did put in.

The Release tag holds the name which tags the initial state of your project. Such
a tag names a certain point within the CVS repository by which you can later
access this state of your development. (See more in the Using CVS chapter.)

The Application Wizard has put a default ‘start’ tag in here which is a worthy
proposal. Just stick to it.

NOTE

When any information of all these is wrong KDevelop usually will not know about
until project construction time. It is the CVS system which will figure out those errors
when it tries to build the repository. Hence you must keep an eye to the Messages
window of KDevelop when the project is created in the final setup step. If anything
was in error with CVS you will in most cases see an error message like this:

* c¢d ’"/home/devel/test’ && cvs -d ’/home/devel/mycvsroot’ «

\
import -m ’new project’ '’ 'vendor’ ’start’ &&\
sh /opt/kde3/share/apps/kdevcvs/buildcvs.sh . 7’ \

"/home/devel /mycvsroot’
* cvs [import aborted]: /home/devel/mycvsroot/CVSROOT: No «
such file or
directory
* *xx Exited with status: 1 **x*

If this happens you will have to either manually set up CVS (KDevelop should have
successfully initialized your project files at this time) or delete the project directory
and start over again with New Project from the Project menu.

After you have entered all CVS related information, click the Next > to go on.

NOTE

If you want to correct an error on the previous Create New Project page, just press
the < Back button. The Application Wizard will remember your settings on the
current page, so you can easily proceed when you come back.

5.1.3 Supply Header/Source Templates

The next step brings you to a series of pages where you can set up common
information you want to include in your source and header files, if the task at
hand allows.
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Both header and source templates are provided for C and C++ applications,
each on its own page. For other languages there may be source templates only.
And in some cases you will even find this template page empty.

If the page is used, Application Wizard will fill in some common header com-
ment which for a C++ based application might look like:

/*************************************************************** Fhkxhkkhkhkkkhkkx o>
* Copyright (C) 2003 by Your Name <«
*
& youlyou.com <«
4
*
* o
«>
*
& This program is free software; you can redistribute it <«
and/or modify *
2 it under the terms of the GNU General Public License as <«
published by *
B the Free Software Foundation; either version 2 of the
License, or w3
& (at your option) any later version. <«
*
* «—
>
*
. This program is distributed in the hope that it will be <«
useful, *
u but WITHOUT ANY WARRANTY; without even the implied <«
warranty of td
L MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE. —
See the t
td GNU General Public License for more details. <«
*
& —
—
*
* You should have received a copy of the GNU General «
Public License *
& along with this program; if not, write to the <«
*
td Free Software Foundation, Inc., <«
*
* 51 Franklin Street, Fifth Floor, Boston, MA 02110-1301, <«
USA. *
Kk khkkhkkhkhkkhkhkhkhkdkrhkhkhkhkhhkhkrhdhkhkhhkrrkhdrrxhhkrxhhkhkrhkdhkrxhkhkhhhddxxkhkkxhkhkdx*xk* ***********/ o

62



KDevelop User Manual

Other templates will provide similar information in a format according to the
definitions of the programming language you want to use.

As you might have noticed, the applications manager did readily fill in some
information you provided on the first General page of the Create New Project
dialog, namely the contents of the Author and Email fields. Also proper license
information will have been inserted according to your selection in the License
tab.

5.1.3.1 How to Edit the Templates

The templates you set up in the Create New Project dialog will later be pro-
cessed whenever you command KDevelop to set up a new source and/or
header file. The information you provided here will be included at top as a
documentation header, before the code parts begin.

You are not restricted to plain text however. KDevelop knows of several vari-
ables which allow you to include actual information in the file. The Applica-
tion Wizard did in fact use some such variables to insert the Author, Email, and
License information into the initial template text.

Include Doxygen File Information If, for example, you want the Doxygen-
built API documentation to display some further information about the
file’s contents in its filenames list, you may include the following lines in
the source file template:

/**
* \file SMODULES.cpp
* \brief (put some short description here).

**/

Whenever you create a new source file, KDevelop will replace the $MOD-
ULE$ variable by the name body of the newly created file. For example,
if you created a new C++ class named ASimpleTest you will see the fol-
lowing lines in the asimpletest.cpp file:

/**
* \file asimpletest.cpp
* \brief (put some short description here).

**/

You will still have to provide the short description after the “\brief’ key-
word, but part of the job is automatically done for you.

The License Text File As another example you could include an explicit hint
to the license text you want to use into the template. Use the $SLICENSEF-
ILES variable for this and add for example this line:

// See SLICENSEFILES for the full license text.
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The Application Wizard will replace the SLICENSEFILES with the name of
the file where the full license text is to be found, namely:

// See COPYING for the full license text.

for the GPL license, or

// See LICENSE.BSD for the full license text.

if you decided to put your application under the BSD license.

Thee are of course more variables KDevelop knows of. See the Editing
the templates section in the Editing tools chapter for what is possible.

NOTE

The templates you define here will come in effect only after the Application Wizard
has created the new project. You will find this information on top of the files you
created yourself in the development process. When creating the initial files the
Application Wizard will use some predefined standard templates. You will have to
manually adapt those initial files to your needs.

5.1.4 Build the Initial Project Files

Almost everything is done now. On the last templates page the Next > button
will have changed to read Finish now.

Think twice before you click on it! You still have the option to revise everything by
repeatedly using the < Back button. As the Application Wizard remembers all
information you did input so far, it may be advisable for you to take the time
and look back once again. In case you use local CVS, do not forget to double-
check the CVS repository name (there should be no subdirectory with that name
in the CVS root directory already—if it does, try another repository name).

If ever you don’t want the new project be built, abort the Create New Project
dialog by the Cancel button. Otherwise click Finish and watch in the Messages
window how the Application Wizard initiates the project.

If you want to use a versioning system (CVS) there will be two runs actually.
Application Wizard will first build the project directories and files and then call
up the CVS program which restarts the Messages window with its own con-
tents. If any error occurs in either of these runs, the process will stop showing
you an according error message in the window.

NOTE

In many cases when your new project has been set up this way, KDevelop will
automatically load the source file(s) of one or more basically important modules
so you can readily start work. (Which source modules will be displayed—if any at
all—however depends on the template initially selected in the Application Wizard.)
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Do not forget to initially check what the Application Wizard has provided. For
example you may want to change the initial heading information according to
your own templates. Usually you will find these in a templates subdirectory
in your project directory. Some simple copy operations will mostly suffice.

Then it is advisable that you compile the initial project before you attempt to
change any code. In most cases this initial compilation should be possible.
Thus you can make up whether the project really was set up according to your
needs. If it was not, simply remove the project directory (in your local CVS
root as well if you use one) and start over again.

WARNING

Before you compile your new project the first time, have a look at Project — Build
Configuration. If there are three selections displayed: default, optimized, and de-
bug, with debug selected, by all means stick to this, or use optimized instead.

Due to some limitations in the current autoconf/automake setup you should by no
means build in the default configuration. This will corrupt some internal directory
settings, thus making configure complain when you try to use it in the optimized,
or debug build configuration afterwards.

(This applies to these multiselection capabilities only. If the application type you
selected provides a default build configuration only, you should of course use this
one.)
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Chapter 6

Editing Tools

6.1 Code Snippets

FEATURES (PRELIMINARY OVERVIEW)

SnippetPart adds a tool-view which by default docks to the right
Adding, editing and removing of snippets is available via a popup-menu

Double-clicking a snippet form the list inserts it into to the active view at the
current cursor position

Tool tips show the content of a snippet

Snippets are stored in the users home-directory, so every user can have his
own snippets

Snippets can contain variables in the style of $VARNAMES. On using the snip-
pet the user is prompted to enter replacement value for the variables

6.2 Keyboard Mapping

In the following, we will list the default keybindings of the default editor. You
can configure them as you like (how?)

Left Moves one character left
Right Moves one character right
Ctrl- Left Moves one word left

Ctrl- Right Moves one word right

Up Moves up one line
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Down Moves down one line

Page Up Moves up one page

Page Down Moves down one page

Ctrl- Page Down Moves to the beginning of the file
Ctrl- Page Down Moves to the end of the file

Home Moves to the beginning of the line
End Moves to the end of the line

For all the keys above, the Shift key can be pressed additionally, to mark from
the current cursor position to the one afterwards.

Backspace Deletes one character left
Deletes the character under the

Delete
cursor

Ctrl-C Cgples the selected text to the
clipboard

Ctrl-V Pz.istes the selected text from the
clipboard
Deletes the selected text and puts

Ctrl-X it into the clipboard

Ctrl- Z Undo

Shift-Ctrl- Z Redo

6.3 The Problem Reporter

(... to be written ...)

6.4 Searching and Grepping
6.4.1 Searching for Text

Ctrl-F- Find Ctrl-R- Replace

6.4.2 ISearch

The conventional search with Edit — Find requires you to specify the full search
term before starting. Most of the time, it is much faster to search incrementally.
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If you click into the edit field labeled ISearch in the toolbar, the search is per-
formed as you type. You will find that often the desired term is already found
after typing in 3 or 4 letters.

6.4.3 Grep

Both search mechanisms described above are restricted to searching within one
source file. An additional tool which allows you to search through a (possibly
large) number of files is available through the Search in Files... item in the Edit
menu. It is basically a frontend for the grep(1) program.

In the dialog, you can specify which files are searched. There is a number of
wildcard patterns available in a combobox. In this way, you can easily restrict
the find mechanism to header files. Furthermore, you specify a directory where
the search is started. If you check the Recursive box, the search iterates through
all directories in the hierarchy below this one.

The search term is in general a regular expression following POSIX syntax. For
example, you can use the term "\<K.*" if you want to find all words which

begin with the letter K. The following characters are interpreted in a special
way:

Matches any character
Matches the beginning of a line

$ Matches the end of a line

\< Matches the beginning of a word
\> Matches the end of a word

) The preceding item matches less
) than once

The preceding item is matched
zero or more times
The preceding item is matched

+ .
once or more times
(n) The preceding item is matched
exactly n times
in ) The preceding item is matched n
! or more times
The preceding item matches less
{/n} .
than n times
The preceding item matches at
{n,m}

least n times but less than m times

Backreferences to bracketed subexpressions are also available by the notation
\n.

68



KDevelop User Manual

For C++ programmers, as special bonus there are some search templates avail-
able for typical patterns. These allow you to search for example all calls of
member functions of a certain object.

Once you start the search by clicking on the Search button, it will be performed
by an external, asynchronous process. All found items will appear in the view
called Grep. You can then jump to the found items by clicking on them. Note
that grep scans the files as they stored in the file system. If you have modi-
fied versions of them in your editor, you may get some mismatches in the line
number, or some found items will be invalid. You can avoid this by saving all
files beforehand.

6.5 Code Completion

(... to be written ...)

6.6 Creating New Files and Classes

(... to be written ...)

6.6.1 Editing the Templates

(... to be written ...)

69



KDevelop User Manual

Chapter 7

The File Browsers

On the left side of the main window, KDevelop can display various kinds of
lists and trees for the selection of files:

File Tree This shows a tree view of the file hierarchy below the project direc-
tory. If you click on a file, it is loaded into the editor. For files which
do not contain text, KDevelop starts an application that can handle the
respective MIME type.

The file tree is regularly updated whenever something changes in the file
system. For example, if you create new files or directories (even outside
KDevelop), this is immediately reflected in the file list. On Linux®), this
feature makes use of the FAM library. On other operating systems or over
NES, the directories shown are polled in small intervals.

The file tree hides files which are usually not interesting, like object files.
In the Project options under File views, you can configure (as a comma
separated list of wildcards) which patterns are used to filter out irrelevant
files.

Furthermore, you can decide to restrict the file tree to show only files
which belong to the currently loaded project. This can be toggled by
clicking with the right mouse button on the root item of the tree.

File Groups This shows the files belonging to the project, grouped by their

file name extension. As in the file tree, you can edit a file by clicking on it
with the left mouse button.
The groups shown in this view can be configured under File views in
the Project options dialog. In order to customize the view to your needs,
it is helpful to understand how files are distributed on the groups. For
each file, KDevelop goes through all groups from top to bottom. In each
group, it looks whether the file name matches one of the patterns. If there
is a match, the file is shown in this group and the iteration is aborted.
This makes it clear that more general patterns should be put below more
specific ones. For example, an asterisk for the Other group should be the
last pattern.
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Chapter 8

The Class Browsers

When working on a project in an object-oriented language, your emphasis
when working on a project is not on the source files and their names, but on
the classes and their relationships. In order to help you navigating in the space
of defined classes and symbols, KDevelop includes various class browsers that
visualize the class structure in different ways.

8.1 Class View

This view is shown on the left side of the main window and contains a linear
list of all classes, variables and functions in your project. It is designed as a

tree view. If you open a class node by clicking on it, a list with all methods and
attributes of the respective class is shown.

The class view works in two different modes. By default, all symbols are
grouped into ‘Classes’, ‘Structs’, “‘Functions’, ‘Variables” and ‘Namespaces’. In
the context menu of the view, you can choose List by Namespaces. In this
mode, the namespace hierarchy is shown and the symbols grouped into the
respective namespace where they are defined. This may be more useful in
projects which make heavy use of (nested) namespaces. It is less useful in
projects without namespaces.

You can also change the way in which class names are displayed. Normally, the
names of the classes are shown, without the namespace in which they are de-
fined. This means, you cannot immediately distinguish classes with the same
name in different namespaces. If you rest for a while with the mouse over an
item, the full scoped name is shown as a tooltip though. You can decide to
always display the fully scoped class name by choosing Full Identifier scopes
from the context menu.

Clicking on a class or method in the class view brings you to its definition. You

can also jump to the declaration of a method by choosing Go to declaration

from the context menu. In the context menu for classes are also the items Add
method... and Add attribute.... This opens dialogs where you can generate
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new method and variable declaration in the respective class, together with an
empty implementation.

8.2 Class Tools

The class tool dialog is activated by right clicking on a class in the class view
and choosing Class tool....

8.3 Class Hierarchy

(... to be written ...)
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Chapter 9

Documentation

Documentation unfortunately belongs to the most-overlooked programming
issues. Yet, once properly set up and maintained internal and external docu-
mentation provides most valuable help.

Documentation has multiple facets. There is

e project internal documentation, mainly consisting of

— comments in header/source files

— internal API documentation of your project generated from the program file
by special tools, e.g. Doxygen

e project external documentation, comprising among others

— external API documentation of e.g. common system libraries (KDE, Qt™,
etc.)

- any other documentation (programming language manuals, general sys-
tem information, how-to articles and the like)

All this documentation should be easily maintainable and ready at hand when-
ever you need it. KDevelop has provisions for just this.

9.1 The Documentation Browser
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Chapter 10

Building and Project
Management

Bernd Pol and Ian Wadham This chapter deals only with compiled projects,
such as C++, Java™ or Fortran projects. Projects for scripting languages like
Python and PHP work very differently.

You will find here information on:

e Summary of Automake Manager containing an initial overall view of Au-
tomake Manager,

e Automake Manager Operation describing the basics of how to work with
Automake Manager,

10.1 Summary of Automake Manager

In the Build systems chapter we have given a rough overview of the build
systems commonly in use on UNIX®) systems. In the following sections we
will look at this in more detail.

There is some confusion about how to name such things. GNU calls them
‘build systems” when it describes Automake, Autoconf and Libtool. QMake
calls itself ‘a tool to write Makefiles for different compilers and platforms’. In
KDE often the term ‘project management systems’ is used. We will use this
term in a broader sense to describe the built-in environments in KDevelop
which are used to organize and build your projects. In the context of this sec-
tion, however, we will mostly talk about ‘automated build systems’.
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10.1.1 The Need for an Automated Build System

If you have a simple ‘Hello World’ program, written in C, you can compile and
link it using gecc —o hello hello.c and execute it using the command ./hello,
so you do not even need a Makefile.

If you have a C application with several modules and header files and you are
only going to run it on your own machine (i.e. it is an in-house application),
you will only need a simple Makefile, which is fairly easy to write by hand
(use info make to find out more).

The complications begin when:

¢ Your source-code, documentation, graphics, sounds, translations, data files,
etc. are located in more than one directory,

¢ You have a hierarchy of directories and sub-directories,

e You are using libraries that are not part of the traditional UNIX®) set, such
as the Qt™ Object Library or the KDE Desktop libraries,

¢ You are using a pre-processor to generate some of your source-code, such as
Qt’s MOC pre-compiler,

e You aim to distribute your application worldwide, to people who may not
have the same UNIX®)/Linux®) system, software and hardware as you,

e You require an automated Install and Uninstall facility,

e You aim to make your application part of the KDE Desktop set.

If you have some or all of the above situations, you probably need a build sys-
tem. In the example above we used gcc to compile and build the ‘Hello World”
program, but not all C compilers are called ‘gec’. So if you distribute your ap-
plication to someone who is using some other C compiler, your Makefile must
somehow use the name of that person’s compiler, otherwise your application
will fail to compile—and that is just simple example of what can go wrong.

A build system will iron out these differences for you.
o It will check that the libraries you need are present on each receiving ma-
chine,

¢ will automatically scan all your application directories for files to pre-process,
compile or install and

¢ will install the components of your application in the correct receiving direc-
tories, making sure that

o the directories are created in the receiving machine as required.

78



KDevelop User Manual

In brief, a build system offers safe and secure methods for your application to
be compiled and installed correctly on any receiving machine. As we have
shown before in the Project Management Systems survey, KDevelop offers
three automated build systems and the option of creating your own Makefile,
in short (click on the project names to get more information):

e Automake projects which use the GNU standard development tools.

e QMake projects which use the trolltech QMake project manager.

e ANT projects which use the Apache ANT project manager for Java™ devel-
opment.

e Custom projects which require you to maintain your own Makefiles.

IMPORTANT

One of these four alternatives must be chosen when you create a project and the
choice is difficult to change later, so you should give it some thought before you
start.

10.1.2 Tutorials on Autoconf/Automake/Libtool

There are several tutorials available on the GNU Build System (Autoconf, Au-
tomake and Libtool) of which the Automake Manager makes use.

e A short autoconf tutorial written by Christopher W. Curtis available on the
KDevelop home page. It concentrates on some basic steps to modify a Mak-
efile.

e A more detailed tutorial can be found in a greater set of tutorials on Devel-
oping software with GNU.

e And there is the famous Goat Book, titled ‘Autoconf, Automake, and Libtool’.
This is an easily readable, yet concise, introduction in all main aspects of the
GNU Autotools.

10.1.3 What does Automake Manager Do?

The Application Wizard will have set up some initial Makefile.am files when
you created a New Project of a type that uses the GNU Build System, such as
C++ — KDE — Application framework. During development Automake Man-
ager creates any other Makefile.an files for projects that use the GNU Build
System and maintains them all, Application Wizard and Automake Manager
created alike.

There will be one Makefile.an file in each directory of your project that con-
tains files to be compiled or installed. It will contain your specifications for
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compiling, building and installing files and a reference to any subdirectories
that also have a Makefile.an file and possibly some files to compile, build and
install.

NOTE
Your project’s directories and source files may be structured to any depth, or you
may prefer a flat project-structure with all subdirectories at the top level.

The aim of the GNU Build System is to produce source-code file structures
that can be compiled, built and installed on any UNIX®) or Linux®) system by
using the simple commands:

./configure
make
make install # Usually as "root".

and can be uninstalled by the command make uninstall (usually as root).
How does this work? Well configure is a script that

e works out the details of whatever system it is in, such as what compiler and
libraries to use and where they are located, and then

e creates recursive Makefile files by filling in the substitutions in the corre-
sponding Makefile.in files.

The Makefile.in are ‘input’ files—templates which provide basic information
for the Makefiles to be produced from them by filling in some system depen-
dent information. They are generated by the Automake utility from the Make-
file.an files.

The process of going from Makefile.am (.am denotes ‘Automake’ template
files) to Makefile files is handled automatically by the KDevelop Project Man-
ager, using the Autoconf utility, M4 macros and other arcana we need not go
into here.

So when make runs, it automatically picks up the correct pieces from the cur-
rent environment, such as compilers and libraries. Similarly, make install puts
your application components, such as executables, documentation and data
files in the correct places for that environment.

If you distribute your application as a ‘tarball’ (a single compressed file that
KDevelop can create for you), it will include the Makefile.in files and the co-
nfigure script file, so the recipient can compile, build and install your applica-
tion without having Automake, Autoconf or KDevelop on their machine. The
Makefile.an files are also included, just in case the receiver needs to do any
source-code modifications.

NOTE
The rules are rather different if you distribute via a web-based source-code reposi-
tory such as KDE CVS.
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10.1.4 Summary of What Automake Manager Does

o Generates Makefile.an files in subdirectories it knows as ‘subprojects’.
e Updates Makefile.am files as the project structure changes.
e Updates Makefile.an files as files are added to or removed from the project.

o Accepts definitions of how the various files are to be built or installed and
modifies the Makefile.am accordingly.

e Accepts parameters used in building or installing (e.g. library names) and
ensures that they are used in the required compilation and build steps.

10.1.5 Contents of Automake Files

A Makefile.an file has lines containing variable-names followed by an equals
sign and a list of files or parameter values. The ‘variables’ have two-part
names, such as bin_PROGRAMS, myapp_SOURCES or kdelnk_DATA. The second part
is called the primary and represents something from which to build or install.
The first part is called the prefix and represents:

e A directory in which to do installation (e.g. bin),

o A qualifier for the primary (e.g. myapp for SOURCES, indicating that the source
files listed after myapp_SOURCES go into building nyapp),

e A special prefix noinst (short for ‘no installation’), usually used to list pro-
gram header files (.h),

o Or the special prefix EXTRA, for configuration-dependent stuff.

For more information on Automake and Makefile.amfiles, look up info Automake.

Basically, Automake Manager creates and updates the variable-names and lists
of files or parameters. See the following example of a Makefile.am for a typical
application, called myapp.

## Makefile.am for myapp

# this is the program that gets installed. its name is used <«
for all

# of the other Makefile.am variables

bin_PROGRAMS = myapp

# set the include path for X, gt and KDE
INCLUDES = $(all_includes)

# the library search path.
myapp_LDFLAGS = $(KDE_RPATH) $(all_libraries)
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# the libraries to link against.
myapp_LDADD = $(LIB_KFILE) $(LIB_KDEPRINT)

# which sources should be compiled for myapp
myapp_SOURCES = main.cpp myapp.cpp myappview.cpp

# these are the headers for your project
noinst_HEADERS = myapp.h myappview.h

# let automoc handle all of the meta source files (moc)
METASOURCES = AUTO

KDE_ICON = myapp

# this is where the kdelnk file will go
kdelnkdir = $(kde_appsdir)/Utilities
kdelnk_DATA = myapp.desktop

# this is where the XML-GUI resource file goes
rcdir = $(kde_datadir) /myapp

rc_DATA = myappui.rc

AM_CXXFLAGS = -DMY_C++_PREPROCESSOR_OPTION

As you can see, many of the items on the right hand side are symbols of the
form $ (xxx). These are environment variables which are defined in the actual
KDE environment and are substituted with real values when ./configure gen-

erates the final Makefile files in the receiving machine.

Also, sometime after you have started with KDevelop, it is a good idea to run
the command ./configure --help, which will show you the range of things you
can change at build and installation time, such as for a test environment. In
particular, the command:

./configure --prefix=/where/you/wish

will re-direct the entire installation to a directory structure of your choice, by
changing the internal variable $ (prefix) to value /where/you/wish.

10.2 Automake Manager Operation

In this chapter you will find a basic description of the Automake Manager ele-
ments and how to use them. This covers:

e The Automake Manager Window describes the basic structure of the Au-
tomake Manager main window.

e The Overall View Window describes the elements of the upper subwindow.
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e The Detail View Window describes the elements of the lower subwindow.

e Navigating in the Automake Manager lists some basic operations you can
perform in the Automake Manager.

e Popup Menus in the Automake Manager describes the windows which will
pop up when you select an action in the Automake Manager.

10.2.1 The Automake Manager Window
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10.2.2 The Overall View Window

The overall view window contains a tree-list of all the directories in your project
that contain program files, documentation or data. Each such directory con-
tains a Makefile.an file and is known in Automake Manager as a subproject.
There are three typical subprojects in a KDE-based project as shown in the
above illustration:

e src —source-code files for your application,
e doc — your user manual or Handbook,

e po — extracts of strings in your source-code files that require translation into
other human languages (e.g. window titles, menu names, button labels, dia-
log box text and messages of various kinds).

Note that the doc subproject always has an en subproject, which you can see
if you click on the + symbol next to the word doc. That is because the base
language of all documentation in KDE is United States English (en). If your ap-
plication becomes part of KDE, the KDE translation teams may translate your
documentation from United States English into other languages and the trans-
lations will go into other subprojects, such as de (German) or fr (French). The
strings in the po subproject may also be translated and stored in other files in
po, thus allowing your application to be operated by people who do not know
English.

NOTE

The doc and po subprojects serve different purposes. doc contains documentation
like a user manual, po contains translatable text strings of the user interface which
is integrated in the source code of this application.

The overall view window serves—amongst other things—as a navigation tool.
If you select a subproject in the overall view window, the corresponding details
will be shown in the detail view window.

10.2.3 The Detail View Window

The detail view contains a tree-list of all the files in the subproject currently
selected in the overall view as well as the compilation, build and installation
rules for this subproject. Thus the two views together can give you access to all
the components of your application and all the information on how to compile,
build and install it.
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10.2.3.1 Targets

The tree-list in the detail view has two levels. The top level consists of so-called
Automake Manager targets and the next level contains lists of files that go to
make up each target.

This concept of an Automake Manager target differs somewhat from what a
Makefile target usually is. In short:

e The definition of how a set of files is to be compiled, built or installed is
known as a target in Automake Manager, but as a variable in Automake itself.

e A target in make is often something quite different, being the parameter of a
make command (e.g. make install, make clean).

However some Makefile.am variables do represent an underlying sub-target
in make.

10.2.4 Navigating in the Automake Manager

In both the overall and the detail view you can left-click on the + or - next to
a subproject or target name to expand or contract the tree view. If you do that
with a subproject in the overall view, it shows or hides the subprojects at the
next level down (if any). If you do it with a target in the detail view, it shows or
hides the list of files that go into that target.

Opening a file for Edit If you left mouse button click on a file name in the detail
view, the corresponding file opens up in KDevelop’s editing window.

Activating the Automake Manager Toolbar Buttons If you left mouse button
click on the name of a subproject in the overall view or target in the detail
view, the name is highlighted and some toolbar buttons become active in
the top part of that view.

NOTE

It is recommended that you use the right mouse-button and popup menus,
rather than the toolbar buttons, because it is then much easier to see and
understand what you are doing.

Operations on subprojects and targets have far-reaching effects on the struc-
ture, compilation, building and installation of your application.

Selecting Actions/Popup Menus If you right mouse button click on the name
of a subproject, target or file, a menu pops up and you can then select
actions to perform on the subproject, target or file, such as add a target to
the subproject, add a file to a target or logically remove the selected file
from its target.
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10.2.5 Popup Menus in the Automake Manager

The following sections explain in short terms which operations the menus
make available which will pop up on right mouse button clicks in the Au-
tomake Manager window. They are meant for overall view only. You will find
detailed descriptions of most operations in a later chapter.

10.2.5.1 The Popup Menu for a File

When you right mouse button click on a file name in the detail view the fol-
lowing menu will pop up allowing you to select one of several operations to
be performed on that file. In the illustration below the hi-16app-myapp.pn-
g icon file was selected from the Icon data in myapp target of the myapp/src
subproject.
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10.2.5.2 The Popup Menu for a Target

When you right-click on a target in the detail view the following menu will
pop up allowing you to select one of several operations to be performed on it.
In the illustration below the myapp (Program in bin) target of the myapp/src

subproject was selected.
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10.2.5.3 The Popup Menu for a Subproject

When you right mouse button click on a subproject in the overall view window
the following menu will pop up which allows you to make major changes to
the structure of your project and the way it is compiled, built and installed. You
can use it to expand or modify the basic project structure that the Application
Wizard has created.
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10.3 Automake Projects

(... to be written ...)

10.3.1 Autoconf

Figure 10.1: Effect of the Configure Script

Makefile.in into Makefile

prefix = @prefix@
INSTALL = @INSTALLGE
build_triplet = @build@
CXX = @CXXg@

prefix = /home/bernd/kde3

INSTALL = /usr/bin/ginstall -c -p
build_triplet = i686-pc-linux-gnu
CXX = g++

config.h.ininto config.h

/* Define if you have libz */

#undef HAVE_LIBZ

/* The size of a ‘int’, as computed by sizeof. */
#undef SIZEOF_INT

/* Define if you have libz */

#define HAVE_LIBzZ 1

/* The size of a ‘int’, as computed by sizeof. */
#define SIZEOF_INT 4

10.3.2 Automake

(... to be written ...)

10.3.3 KDevelop’s Automake Manager
10.3.4 Building and Installing Libraries

e -rpath

91




KDevelop User Manual

Figure 10.2: A screenshot of the automake manager

e PIC
e static

e plugins: no-undefined

10.4 Custom Makefiles and Build Scripts

(... to be written ...)

10.5 Compiler Options

(... to be written ...)

10.6 Make Options

(... to be written ...)

92



KDevelop User Manual

Chapter 11

Advanced Build Management

11.1 Multiple Build Configurations

(... to be written ...)

11.2 Cross-Compiling

When you have suitable cross compilers available, you can cross compile your
programs for processors and operating systems different from the system where
KDevelop and the compiler is running. The GNU compiler collection gcc can
be configured and compiled as a cross compiler if you compile it yourself. Con-
sult the GCC info pages for more information. Some Linux®) distributions also
provide binary packages.

An automake based package can easily be cross-compiled by specifying the -~
~host option to the configure script and setting the CC and CxX environment
variables to the respective cross compiler binaries. Often you want to switch
between a the cross-compiled version of your application and one compiled
for your development system. For this, it is advantageous to use KDevelop
capability of creating multiple build configurations, as explained in Section
11.1. Once you have created a new build configuration for cross-compiling in
the Project — Project Options... dialog, add the option

--host=platform

to the configure options. The p1at form name is a tuple of the form

cpu-vendor-o0s

or
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cpu-vendor-kernel -o0s

For many combinations, you can use a short form, for instance i386-linux or
arm-elf.

11.3 Qt/Embedded

Qt/embedded is a version of the Qt™ library that does not use the X win-
dow system, but draws directly to the framebuffer on Linux® systems. It is
therefore interesting for embedded systems which have tight restrictions on
the memory usage of the whole system. Its API is fully compatible with the
one of the X11 version.

Developing an application for Qt/embedded with KDevelop is not very differ-
ent from developing a program for the X11 version of Qt™. In fact, you can use
the same codebase for both versions. If you use the autoproject project man-
agement, you switch to the embedded version by passing the argument —-en-
able-embedded to the configure script. You can set this in the Project — Project
Options... dialog under Configure Options. With the option --with-qt-dir=-
DIR you set the directory in which Qt/embedded is installed.

After configuring and compiling your application with these options, it will
link with the libgpe.so library. This version of your application will not nor-
mally run when you use X11. In order to test it, run it under the control of the
program qvfb (Qt™ Virtual Frame Buffer). This is done by starting qvfb and
then starting your application with

app -qws -display QVFb:0

Naturally, when you have a working version of your application, you will want
to use it on the target processor. For this, it will probably be convenient to cre-
ate multiple build configurations, as explained above, so that you can quickly
switch between the version running on your development system and the ver-
sion running on the target system.

Applications for Qt/embedded normally run as single applications on the de-
vice they are designed for. Trolltech also supports Qtopia, which is a collection
of applications for PIM, web browsing and various other areas that work to-
gether in a consistent manner. It is the standard environment for instance on
the Sharp Zaurus. You can write applications that integrate into this environ-
ment by using the Qtopia SDK. This implies making your application class a
subclass of QPEApplication and linking to the library libgpe.so. If you de-
velop your application with the autoproject project management, you have to
add --enable-qgtopia to the configure options.
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Chapter 12

The Debugger Interface

For C and C++, KDevelop contains an internal debugger that is directly inte-
grated with the editor. Technically, it is implemented as a frontend that uses
the portable GNU debugger gdb through a pipe. The debugger can be started
in several ways:

With Debug — Start, the main program of your project is loaded into the
debugger.

Using Debug — Start (other) — Examine core file you load a core file into
memory, which is generated by the operating system kernel when the pro-
gram has crashed (The generation of core files may be switched off on your
system, see ulimit(1)). This is useful for a post-mortem analysis of a program.

With Debug — Start (other) — Attach to process you invoke the debugger on
an already running program. You will be shown a process list where you can
select the process which the debugger should take over.

Note that debugging is only possible if your project has been compiled with
debugging information enabled. It can be activated in the Compiler options
dialog. When this option is switched on, the compiler generates additional
data which allows the debugger to associate file names and line numbers
with addresses in the executable.

The debugger frontend offers several views ‘into” the process:

If you try to debug a project without debugging information, you get the mes-
sage No source... in the status bar.If you try to set a breakpoint, it is shown
as Pending (add) in the breakpoint window (see below).

Variables This window lists the values of all local variables at the current ex-
ecution point of the program. It covers the variables in the complete call

stack, i.e. the function where the process was interrupted, the function
that called this function, and so on up to main () function.
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Another branch in the variables contains watch variables. You can con-
figure yourself which variables are shown here. Both local and global

variables can be watched. You can add variables either by clicking on the
Add button or pressing Return while the Watch item is selected. They
can be removed again via the context menu.

Frame Stack (... to be written ...)

Breakpoints This window allows you to see and manipulate the breakpoints.
Remember that KDevelop uses GDB, so to fully understand the KDe-
velop debugging features, you should know a little bit about the GDB.
If you want to look at the source code, breakpoints are defined in kdeve-
lop/languages/cpp/debugger/breakpoint.h.

At the left edge, the window has buttons to:

Add an empty breakpoint
Edit the selected breakpoint
Delete the selected breakpoint

e Remove all breakpoints

The main part of the window is a table with 7 columns. Each line in the
table is a breakpoint. The columns are:

1. Selection checkbox
2. Type: one of: Invalid, File:Line, Watchpoint, Address, Function

3. Status. Values are:
o Active
e Disabled: Each breakpoint may be ‘enabled’ or ‘disabled’; if dis-
abled, it has no effect on your program until you enable it again.
e Pending (add): a breakpoint is marked like this if no debugging
information is available. From GDB Info page:
If a specified breakpoint location cannot be found, it may
be due to the fact that the location is in a shared library
that is yet to be loaded. In such a case, you may want GDB
to create a special breakpoint (known as a ‘pending break-
point’) that attempts to resolve itself in the future when an
appropriate shared library gets loaded.

Pending (clear)
Pending (modify)

Location in the format filename:linenumber

Condition

Ignore Count: If this is a number COUNT greater than zero, the next C-
OUNT times the breakpoint is reached, your program’s execution does
not stop; other than to decrement the ignore count, gdb takes no
action.

9. Hits: counts how many times a breakopint has been hit.

PN A

Disassemble (... to be written ...)
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12.1 Setting Breakpoints

(... to be written ...)

12.2 Options

Display Mangled Names In C++, function names in the executable are ‘man-
gled’, i.e. the function names include information about the argument
types. This is necessary in order to support overloading of functions.
The mangling algorithm is not standardized and differs even between
different versions of the GNU C++ compiler.

In the disassembling window, normally unmangled names are displayed,
so function signatures appear in the similar way as in the source code, so

they are easily readable. Alternatively, you can decide to see mangled
narmes.

Try Setting Breakpoints on Lib Load The debugger backend gdb does not al-
low to set breakpoints within code that is not currently loaded. In a
highly modular application, where often code is only loaded on demand
as a plugin (using the libc function dlopen (3)), this can be inconvenient.
Therefore, KDevelop rolls its own support for breakpoints in shared li-
braries. If you set this option, it allows you to set breakpoints in li-
braries which are not loaded. Then, whenever gdb notifies that a library
is loaded, KDevelop tries to set the pending breakpoints.

Enable Floating Toolbar (... to be written ...)
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Chapter 13

Using CVS

13.1 CVS Basics

CVSis the revision control system which many open source projects - including
KDE — are using. It stores all sources codes in a central place, called the repos-
itory. From the repository, developers can check out a current version of the
project or snapshots of it at arbitrary points of time. In contrast to some other
revision control systems, it is not necessary to lock files one wants to work on.
So development can be highly parallelized.

Whenever a developer has finished a task, he commits his code (accompanied
by a log message). CVS takes the job to merge the changes made by several
developers. It can of course happen that developers work on the same piece of
code, resulting in a conflicting set of changes (in practice this occurs seldom,
and is often a sign of a lack of communication). In this case CVS rejects a
commit; only after all conflicts are resolved, a file can be committed.

So far, this has been a description of the basic features of CVS one usually has to
cope with. But CVS can provide a lot more: One can maintain several branches
of a project (e.g. KDE 1.1.2 and KDE 2 were branches in KDE’s development
tree), merge changes from one branch to another, ask for differences between
revisions, the revision history of files etc.

CVS is implemented as a client-server system. As a user, all communication
with the repository goes through the command line program CVS. A higher
level user interface is available through frontends like Cervisia (http://cervisia.
sf.net) or TkCVS (http://tkevs.sf.net). In KDevelop, only a small part of
the CVS functionality which is important for your daily work can be used di-
rectly.

Basic knowledge of CVS usage is assumed. In particular, you should know
how to checkout a given project from the repository. We recommend the book
‘Open Source Development With CVS’ by Karl Fogel which is freely distributed
(except for the non-technical chapters). See http://cvsbook.red-bean.com/
cvsbook.html.
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13.2 CVS Commands in KDevelop

In the file views, the following context menu items are available:

Add to Repository Prepares the marked file for addition to the repository. The
file is transferred to the repository when you commit it (or the containing
directory) the next time.

Remove from Repository Prepares a file for removal from the repository. This
also deletes the file on the local file system, so use this feature with care!

Update Runs cvs update to merge any changes from other users into your
working directory. When you use this menu item over a directory, the
update normally happens recursively, except if you have disabled this in
the configuration file .cvsrc.

Commit Runs cvs commit to upload any locally made changes to the repos-
itory. Note that you should update before doing this. Otherwise, when

another user has committed his own changes before, CVS may give you
an error message.

All these commands are invoked as subprocesses by KDevelop without any
further command line options or environment variables. This may be a prob-
lem when the connection with the CVS server goes through a ssh connection
and requires that you enter your password each time you commit or update.
This is for instance necessary when your project is hosted on sourceforge.net.
Workarounds for this problem are described on the CVS/SSH FAQ which you
can find in the SourceForge documentation.

13.3 Behind the Scenes

13.3.1 What CVS Records in the Working Directory

(... to be written ...)
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Chapter 14

Credits

14.1 Contributions

e The initial contents of this manual were written by Bernd Gehrmann bernd@kdevelop.org
and Caleb Tennis caleb@aei-tech.com.

e The Summary of Automake Manager and Automake Manager Operation
chapters were written by lan Wadham, ianw@netspace.net.au).
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Appendix A

Installing KDevelop

In this chapter we will discuss the steps necessary to compile and install the
KDevelop IDE:

e How to obtain KDevelop mainly concentrates on downloading the most re-
cent KDevelop sources from CVS.

e KDevelop requirements lists the programs and libraries which you need in-
stalled to successfully compile the IDE.

e KDevelop compilation and installation leads you through all the steps of
compilation and installation of the application.

e How to obtain a KDevelop API documentation tells what an API is and how
you get such a useful tool for navigating the KDevelop sources.

A.1 How to Obtain KDevelop

KDevelop is available in binary form from many different Linux® distribu-
tions such as SuSE, RedHat and others. These binaries are packed in some
convenient format, mostly RPM, for easy installation. To install, follow the
standard instructions given in your distribution.

You may as well obtain the KDevelop sources, compile and install them by
yourself. These sources can be found via the project home page at http:/ /www.kdevelop.org
or via the KDE ftp site.

A.1.1 Get Daily KDevelop Snapshots from CVS

If you want be in front of current development, anonymous CVS repository
snapshots are available. The module name is kdevelop at :pserver:anonymous-
@anoncvs.kde.org: /home/kde.
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A.1.1.1 Initial CVS Checkout

To obtain an initial version of KDevelop you must download it from anony-
mous CVS. For this so-called checkout operation follow these steps.

NOTE
We assume you want to put your KDevelop copy into the kde3src subdirectory of

your home directory ( ).

# Create the destination directory, if necessary:

> mkdir kde3src

> cd kde3src

/kde3src> cvs -z3 -d :pserver:anonymous@anoncvs.kde.org:/home/kde co kdevelop
/kde3src> cd kdevelop

NOTE
Once you have successfully checked out your KDevelop version, you may keep up
with the changes using the update procedure shown in the next section.

IMPORTANT
Keep the server load low. Please do not checkout every time you want to keep your
KDevelop up to date! Use CVS update for this purpose.

Now you may compile your KDevelop version as shown in the KDevelop
Compilation and Installation section.

A.11.2 Keeping Your CVS Copy up to Date

After you checked out (and successfully compiled) KDevelop from CVS as
shown above, you'll want to keep it up to date in order to get all the patches.
Follow these steps. (We again assume you have put your KDevelop copy into
the kde3src directory.)

Note the up (= update) command instead of the co (which stands for checkout).

> cd kde3src
/kde3src> cvs -z3 -d :pserver:anonymous@anoncvs.kde.org:/home/kde up kdevelop

/kde3src> cd kdevelop

NOTE
Keep an eye on the messages CVS produces during the update sequence. The
exact steps in the compilation sequence depend on this.

Now you can compile a new KDevelop version as shown in the Special CVS
compilation considerations chapter.
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A.2 KDevelop Requirements

In order to successfully compile and use KDevelop, you need the following
programs and libraries. They are available on most platforms as distribution
packages and thereby can be installed easily.

REQUIRED:

o gcc/g++ &#8805; 2.95.3 (or compatible)
Available from gcc.gnu.org

¢ GNU make (or compatible)

Available from www.gnu.org/software/make

e Perl 5.004 (or higher)

Available from www.perl.com

e autoconf &#8805; 2.52 (or higher)

Available from www.gnu.org/software /autoconf

e automake &#8805; 1.6 (or higher)

Available from www.gnu.org/software /automake

o flex 2.5.4 (or higher)

Available from www.gnu.org/software/flex

o Qt™ &#8805; 3.0.3 (or higher)
Available from www.trolltech.com/products/qt

o KDE &#8805; 3.0.2 (or higher)
Available from www.kde.org

OPTIONAL:

e The ctags source navigation tool, from http://ctags.sourceforge.net, which
enables you fast access to declarations and definitions by a few simple clicks
on a name in the editor.

e dot, a graphics language compiler, from http:/www.graphviz.org. This tool
is needed in conjunction with Doxygen below if you want to have class rela-
tionships graphically displayed (which is highly recommended).

e The Doxygen documentation tool, from http:/ /www.doxygen.org if you want
to generate concise and powerful API documentation from your projects.

e ovalgrind from http://developerkde.org/ sewardj/ helps you to find mem-
ory management problems in your applications.

e CVS from http://www.cvshome.org if you want to use the CVS versioning
system.
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e Any other compiler and/or tool in case you want to develop for another
language/platform than C++/KDE or use some special facility.

NOTE

1. You can, to a certain extent, circumvent the need for autoconf &#8805; 2.52
and automake &#8805; 1.6. Just remove the admin directory in your KDe-
velop installation directory and type

(your-kdevelop-directory)> In -s SKDEDIR/share/apps/kdelibg/admin admin

at the console. This causes KDevelop to use the standard settings in the
KDE admin directory instead.

2. Be careful not to mix Qt™ versions. Always link KDevelop to the same Qt™

version your KDE library was compiled. Otherwise you will most likely expe-
rience very strange behaviours.

A.3 KDevelop Compilation and Installation

Once all requirements are met, you are ready to compile and install KDevelop.
This appendix will discuss the necessary steps to do so.

e Preliminary Steps tells you about setting up a proper environment.

e Compile KDevelop deals with obtaining the KDevelop sources from CVS,
how to prepare them for the installation process, and finally shows the steps
necessary to compile and install KDevelop.

e Some Notes on configure Options tells you how to run KDevelop if it has
been installed in a location other than the KDE directory.

A.3.1 Preliminary Steps

Before entering the compile sequence you must make sure all libraries and
tools are available to the make system. To accomplish this some environment
variables need to be properly set. The actual steps to be performed depend on
the console shell you use.

NOTE

To avoid typing in all the statements that set the necessary environment variables
every time you want to compile, you should put them into your .bashrc or .cshrc
file. This way the environment variables will be properly set every time you start the
shell.
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A.3.1.1 Setting the Environment for the bash Shell

If you use the bash shell add the following lines:

export KDEDIR=(path to your KDE installation)

export QTDIR=(path to your Qt library)

export LD_LIBRARY_PATH=$QTDIR/1ib:$KDEDIR/lib:$LD_LIBRARY_PATH
export LIBRARY_PATH=$QTDIR/1ib:S$KDEDIR/lib:S$LIBRARY_PATH
export PATH=$QTIDIR/bin:$KDEDIR/bin:$PATH

A.3.1.2 Setting the Environment for the tcsh Shell

If you use the tcsh shell add the following lines:

setenv KDEDIR (path to your KDE installation)

setenv QTDIR (path to your Qt library)

setenv LD_LIBRARY_PATH=$QTDIR/1ib:$KDEDIR/1ib:$LD_LIBRARY_PATH
setenv LIBRARY_PATH $QTDIR/1ib:$KDEDIR/1ib:SLIBRARY_PATH
setenv PATH $QTDIR/bin:$KDEDIR/bin:$PATH

A.3.2 Compile KDevelop

NOTE
In the following discussion we assume that you have put your KDevelop sources in
the /kde3src/kdevelop directory.

A.3.21 Special CVS Compilation Considerations

In case you use a KDevelop snapshot from CVS the initial compilation steps de-
pend on whether you just did a complete checkout or only updated the source.

After a CVS Checkout You must initialize the make system after a fresh check-
out. The same is true every time you need to start over from scratch.

Type:
/kde3src/kdevelop> make -f admin/Makefile.common cvs-clean

and then all of the following steps.

NOTE
You might need access to the CVS repository for the clean-up if any corrupted
or missing files must be reconstructed.
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IMPORTANT
The cvs-clean command will remove every file not in CVS from the directory!
Make sure to back up any valuable information before you issue this clean-up

command.

After a CVS Update The next step depends on the output of the CVS update
sequence. If you got something like (there may be a U or a P marker in
the leftmost column, both denoting the file has been changed):

U /some_directory_path/Makefile.am

or if you just did a full checkout, you must enter:
/kde3src/kdevelop> make -f Makefile.cvs
before you proceed with all of the following steps.

A.3.2.2 Basic make Command Sequence

Once the basic make system is set up you must decide which type of the KDe-
velop system you want to use. This is done in the following configure step
which builds the actual Makefiles the make command will use.

NOTE

You may drop the --prefix option in the following configure command lines if you
want KDevelop be installed in the default KDE directory. See the Some notes on
configure options chapter for this.

A Debug-Compiled Version If you want to keep track of what your KDevelop
application does at run-time you may build a debug-compiled version.
Just command configure to do so:

/kde3src/kdevelop> ./configure --enable-debug=full --prefix=(where-your-kde3-is)

A Release-Compiled Version If you only want to use KDevelop as-is a (smaller
and faster running) release version suffices. configure defaults to this.

/kde3src/kdevelop> ./configure --prefix=(where-your-kde3-is)

NOTE
If you want to build your own AP| documentation for KDevelop you must in-
clude yet another option in the configure command:
/kde3src/kdevelop> ./configure --(options-as-above) \
--with-kdelibsdoxy-dir=$KDEDIR/share/doc/HTML/en/kdelibs-apidocs
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Make and Install KDevelop configure will check the system and build some
Makefiles according to what it found. The make command will use the
main Makefile by default. Thus

/kde3src/kdevelop> make

suffices. If necessary, now gain root user rights using the command
/kde3src/kdevelop> su

and entering the root password. Then install the application:
/kde3src/kdevelop> make install

That’s all. If you installed KDevelop in the default KDE directory you
may now run the IDE. Otherwise some additional steps will be necessary
as shown in the Non-default installation directory section below.

NOTE
In fact there usually will have been three KDevelop-based applications in-
stalled:

e The KDevelop IDE — this is the place where you will usually work.

e The stand-alone KDevelop Assistant documentation browser — isolates
all the powerful documentation facilities of the KDevelop IDE in a separate
tool. This comes in handy when you want to look up some programming
documentation but do not want to start the full IDE.

e The KDevelop Designer — enhances the Qt™ User Interface Designer by
KDE specific elements and integrates nicely in the KDevelop IDE.

A.3.3 Some Notes on configure Options
A.3.3.1 Non-default Installation Directory

By default configure prepares the IDE to be installed in the default KDE direc-
tory. This is necessary because KDevelop assumes direct access to some tools
and parts which reside there. If want to use your own installation directory,
you must tell configure this by the --prefix option:

/kde3src/kdevelop> ./configure --prefix=(where-your-kde3-is)

There is a caveat if you do so. You must provide a means for KDevelop to
access the needed tools and parts in the KDE directory when running. (You
can still use the IDE without doing so, but with very restrained capabilities.)

Call up a shell and have the following commands executed before you start
KDevelop at the shell prompt.

107



KDevelop User Manual

NOTE
Take care to use the plural: It is 'KDEDIRS’, not just ‘KDEDIR’)

> export KDEDIRS=/usr/local/kde:/opt/kde3
> kbuildsycoca

(Now start KDevelop:)
> kdevelop

NOTE
The KDEDIRS environment variable must be set to the list of active KDE directories in your system. We use

/usr/local/kde:/opt/kde3
as an example only.
The /usr/local/kde directory may for instance contain an incomplete KDE version you compiled for debug purpose

In a tcsh shell you must set the environment variables using:
> setenv KDEDIRS /usr/local/kde:/opt/kde3

The kbuildsycoca command (‘build system control cache’) looks around for
libraries and caches their location and version, so that KDevelop can find them.
The caveat is that it takes noticeable time—and it has to be run any time you
call up the shell to start KDevelop from a non-default directory. You may want
to put the above commands into a shell script to reduce the typing effort.

(You could as well put the lines in your .bashrc or .cshrec file, but this is not
advisable as kbuildsycoca will then be run any time you call up the shell.)

NOTE

The kbuildsycoca command does not run from within the root. You must call it from
a non-root user. (But is not a very good idea after all to do software development
from within the root!)

A4 How to Obtain a KDevelop API Documenta-
tion

API is the short form of ‘Application Program Interface’. Actually such an
API contains a series of descriptions (i.e. calling conventions) by which an
application program can access the operating system and other services. In our
context, however, a broader definition was adopted. The API of a KDE or Qt™
application is an abstract of the classes and methods interfaces, a synopsis to
be used like a dictionary to navigate the sources.

There is a version of the most current API available at the KDevelop-Home
website. It will be automatically updated every 24 hours so you can keep up.
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Alas, this version is best used read-only over the internet. If you do not always
have internet access you may as well build your own API documentation from
the KDevelop sources. To do so, you must tell the automake system where
to find the KDELIBS API in your system. This is accomplished by the special
option --with-kdelibsdoxy-dir in the configure command when you prepare
to compile the KDevelop sources:

/kde3src/kdevelop> ./configure --(options-as-usual)\
--with-kdelibsdoxy-dir=$KDEDIR/share/doc/HTML/en/kdelibs-apidocs

(make will replace the global $KDEDIR variable with the actual KDE directory
setting recorded therein.) Then issue a make command as usual. After the
KDevelop IDE has been built you have the option to build the API as well. For
this you must issue

/kde3src/kdevelop> make apidocs

This will build a Doxyfile in your KDevelop base directory which in turn will
be processed by the Doxygen application to build quite a lot of .html API files.
When this rather lengthy API building process (may last more than an hour on
a slow system) finally comes to an end, you must install the API just like you
have to install the KDevelop IDE itself. If necessary obtain superuser rights by

/kde3src/kdevelop> su
and entering the root password. Then install the API files:
/kde3src/kdevelop> make install-apidox

Once this is done, make will inform you about the directory where you can
finally look at the API documentation’s contents. Note this address, you can
use it from Konqueror as well as from inside KDevelop, in case you have set
up the KDevelop sources themselves as a project to work on.

NOTE

You will most probably see a lot of warning and/or error messages during the API
build run by Doxygen. It is best to ignore them, they are of interest to the KDevelop
developers only. If the APl generation ever comes to a successful end, the .html
API files will be usable.

109



KDevelop User Manual

Appendix B

In a Nutshell — Tips and
Tricks

The information in this chapter is meant as a quick reference for a head start
or if you (momentarily) forgot about some basic concept. There are also short
hints on how to solve some common problems when working with KDevelop.

If you want more information on a topic, just follow the link in the title starting
that advice.

Information on these topics is availabe:

Look and Feel

Projects

Compilation

Automake Manager
Compile/Make Problems
Other Topics

LOOK AND FEEL

Force smaller tool view tabs in IDEAI Mode By default KDevelop starts with

large text-based tool tip tabs around the work area. You may change this
look to e.g. save space in the KDevelop configuration dialog (Settings
— Configure KDevelop... — User Interface).
If you use an older KDevelop 3 version, this configuration dialog may
not be available. To change the toolview tabs display manually, place a
MDIStyle entry under the [UI] tag in your $KDEHOME/share/config/kde-
veloprc configuration file as follows:

MDIStyle=0: icons only
MDIStyle=1: text only (default)
MDIStyle=3: icons and text

110



KDevelop User Manual

Weird colored characters and/or display style If you notice random colored
letters everywhere (i.e. on tabs, on tool bars, etc.) and the KDevelop
window seemingly uses a wrong display style, this may help:

o Inyour $SKDEHOME/share/config/kdeveloprc configuration file find the
line containing ‘Style=Checked” and remove it. Then restart KDevelop.

(This behaviour does sometimes occur after you left clicked a .ui file in
one of the file navigators and KDevelop did load KUIViewer to show the
GUI which was produced from this file.)

Full screen mode Select View — Full-Screen Mode from the menus or press
Ctrl-Shift-F.

Hide/Unhide the menubar To hide the menubar select Settings — Show Menubar
from the menus or press Ctrl-M. To redisplay the menubar only Ctrl-M is
available.

PROJECTS

Create New Project Project — New Project... will start the Application Wiz-
ard.

Create a custom project There is no direct way to create a custom project (i.e. a
project which does use its own makefiles). Use Project — Import Existing
Project instead. Remember to set the appropriate Project Type, labeled by
an additional ‘(Custom Makefiles)’, in the dialog.

Use project options early Whenever you start a new project do not forget to
set the Project — Project Options... to your needs.

COMPILATION

Missing detail in compilation messages If during compilations you notice some
valuable information is missing in the Messages Output View window, it
may be that the level of message detail is set too low. right mouse but-
hglgn%ick in the window and select another detail level from the context

AUTOMAKE MANAGER

Create new files in a project Select the sub-project in the upper half of the Au-
tomake Manager, then right mouse button click in the lower half on the
groups title you want to have the files added and select Create New File....

Add existing files to a project Select the sub-project in the upper half of the
Automake Manager, then right mouse button click in the lower half on
the groups title you want to have the files added and select Add Existing
Files....

Remove a file from a project Select the sub-project in the upper half of the Au-
tomake Manager, then in the lower half open the groups list you want to
have the file removed from, right mouse button click on the file in this
list and select Remove.
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COMPILE/MAKE PROBLEMS

Project does not build again after switching to/from default target Thereisa
problem with the automake/autoconf machinery. If Project — Build Con-
figuration provides to select from three build directories: default, op-
timized, and debug, by all means stick to either the default or the de-
bug/optimized targets.

e Once you configured your project with default it will no longer build
with debug or optimized.

e Once you configured your project with debug or optimized it will no
longer build with default.

‘Wrong autoconf version’ etc. Error There are several error messages concern-
ing too old versions of autoconf etc. prohibiting configure to work prop-
erly. Run autoreconf in the directory tree where the configure.in files
in question are. This command will try to update the information in the
GNU Build System files. See man autoreconf for more information.

OTHER TOPICS

Configuration Files used by KDevelop Usually you should not need to care,
but this is very useful to know in case something went wrong with your
setup.
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Appendix C

Development on UNIX

C.1 Some Historical Remarks

From the beginning, UNIX® has maintained two very different development
paradigms. One is the world of system and application programming languages,
where some source code is translated to machine code by a translation pro-
gram, usually a compiler or an interpreter. The programming language C is an
example. UNIX®) was the first operating system kernel to be written in such a
high level language instead of tightly machine-oriented assembler which was
common before that time. (In fact, the C language once even was invented
to write the UNIX®) kernel and associated programs on a DEC PDP-11 com-
puter.)

The other paradigm is the world of scripting languages. This world evolved
with the invention of the UNIX®) shell which was the user’s interface to the
operating system—and at the same time a very high level programming lan-
guage. A shell script is built from a set of small utility programs like e.g. grep,
sed, or find. Each such utility is designed for some tightly defined job. The
trick is that any such utility can be connected to another one via a simple trans-
port mechanism, called a pipe, which directs the output of the foregoing utility
into the input of the next processed one. This makes for a very powerful and
highly flexible programming tool.

As time has gone by, both worlds have evolved. While C is still used mainly
as a system programming language, C++ as a variant of C enriched by object-
oriented and generic extensions has found its place for the development of
complex applications in the 1990’s. There are numerous other programming
languages, even older ones keep their place—FORTRAN77 and Ada e.g. still
have their stronghold in numerical applications.
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C.2 Contemporary Scripting Languages

In the scripting area, there has been a shift away from the shell, which suf-
fers from portability concerns, to languages which unify all commonly needed
functionality in their standard libraries, while still being able to interface to the
outside through pipes when necessary.

All these scripting languages have in common that they are widely portable be-
tween UNIX®) variants, Microsoft Windows®), Mac® OS or even VMS. Also,
they all have implementations that are freely distributable.

C.2.1 Perl

Perl has become popular as a text processing and system administration lan-
guage. In the beginning of the World Wide Web, CGI scripts written in Perl
were a widely used method to create dynamic web pages from databases. To-
day, this method has been replaced mostly by the mod_perl plugin for the
Apache web server. Among Perl’s strengths are its built-in support for ad-
vanced regular expression matching and its rich archive of freely distributed
modules.

For more information see the Comprehensive Perl Archive Network (CPAN)
website.

C.2.2 Python

Python shines by the elegance of its class system and the ease and flexibility
with which external libraries can be wrapped in a way that they appear like
standard Python classes and functions. In contrast to Perl, Python has a clear
and concise embedding API, which makes it the language of choice for making
C and C++ programs scriptable.

C.2.3 PHP

PHP was invented as a language directly embeddable into HTML pages and
consequently has its main uses in delivering dynamic content on the web.

C.3 Higher-level Scripting

Higher-level UNIX®) applications usually miss the speed and flexibility of the
traditional character-oriented shell scripting mechanisms. This is especially
true in the world of graphical user interfaces (GUI) such as e.g. KDE.

There have been attempts to provide similar mechanisms which will work on
a higher application level, most notably CORBA and, in the KDE environment,
DCOP.
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C.3.1 The CORBA Protocol

CORBA (Common Object Request Broker Architecture) is an attempt to let com-
puter applications work together over networks. It was devised by the private,
vendor independent OMG (Object Management Group) standards committee.

CORBA-based programs use the IIOP standard protocol to communicate. Im-
plementations based on IIOP are available on a wide variety of operating sys-
tems, programming languages, and networks and are thus highly portable.

The main drawback of CORBA is its rather low speed. While this may be tol-
erable in networks, it is a real hindrance for inter-application communications
in a non-networked environment such as KDE running on a single computer.

C.3.2 The DCOP Interface

Another evolution on UNIX®-like scripting is the DCOP protocol which was
devised for communication between KDE applications to overcome the limita-
tions of CORBA.

DCOP stands for Desktop Communication Protocol and is implemented as a sim-
ple IPC/RPC mechanism built to operate over sockets. In effect this provides
facilities similar to the traditional UNIX®) pipe mechanism.

Traditional shell scripting is based on fairly small tool programs which were
designed to work on a strictly textual basis. DCOP allows elaborate graphical
programs to communicate with each other in a quite similar way. This enables
e.g. a KDE program to send messages to another KDE program, or receive data
from it for its own purposes.

There are drawbacks, however. To use DCOP a program must be designed to
contain a special DCOP interface. And the DCOP communication process runs
somewhat slowly (although a lot faster than CORBA). But it returns much of
the power and flexibility of UNIX®) scripting to high-level programs which are
based on a graphical user interface.

For more information, see the DCOP: Desktop COmmunications Protocol pa-
per or The DCOP Desktop Communication Protocol library API reference of
the KDE dcop library.

C.4 Build Systems

Except in very simple cases a programming project will consist of a lot of build-
ing blocks of source code each put into a separate file for easier maintenance.
To make this running one has to effectively translate all this stuff into a few
machine language units in a suiting format which allows the operating system
to load and execute the program.

To accomplish this, the basic tools needed are
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e a text editor to write the source code files,

e a translating program, usually a compiler to turn the source code into object
files,

e a librarian which collects object files into libraries to reuse them easily with-
out the need to recompile,

e a linker which binds several object files and libraries together into one exe-
cutable,

e a make system which provides some means to manage all this stuff and—not
to forget

e a debugger to (hopefully) find all errors in the program and possibly some
other diagnostic tools to get everything running smoothly.

When you have a large project consisting of possibly hundreds of source code
files, the process of compiling may become quite laborsome. You do not want
to recompile all files each time you have changed only some of them. Instead,
you only want to compile those files which are affected by the changes. In
general, it is not always easily obvious which of the files have to be recompiled.

When you e.g. change a function prototype in a header file, you need to com-
pile every file which includes this header file. If your project contains many
such files you may easily miss one or two of them if you have to do the job
manually. Thus some means of automatization is necessary.

C.4.1 The Make Process

A tool which takes care of recompilations is make. It keeps track of all work
using a set of rules which describe what to do in case some piece of information
(usually a source or object code file) was changed. All rules belonging to a
certain project are stored in a so-called Makefile which is processed by make
any time you want to update your work.

Each rule consists of several building blocks, namely

e atarget, i.e. the file to be built

e a set of dependencies, basically the names of those files the target depends on
(e.g. the name of a source file, where then the target will be the name of the
object file to be built) and

o the commands which are to be executed to ‘make’ the target (i.e. to compile it
or to link other object files together to build an executable program file).

Basically the make command will read the rules one after another, check each
file in the dependency list of a given target and make this target anew if any
one of these files has changed, using the commands listed in that rule.
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There are several additional possibilities to control such a make process, and
a Makefile can thus grow very complex. We cannot go into the details here.
However, we recommend that you make yourself accustomed to the syntax of
make. Even if you do not normally use it directly, an understanding of the
fundamentals of the build system can be useful. See the GNU Make Manual
for more information.

For more KDevelop specific detail see the Building and Project Management
chapter of this manual.

There are several tutorials available, see the references in the Building and
project management chapter.

C.5 GUI Development

Application developers become even more encumbered by having not only to
create program libraries and logic, but also to provide an easy to use custom
built user interface that is both intuitive and functional. Most programmers
receive little to no training in GUI development, and as a result user interfaces
often are poorly designed.

During the years some common design principles have evolved. It is strongly
advised to adhere to them. This way your user interfaces will retain a common
look and feel that the users of your application will gratefully appreciate.

For KDE GUI development there is a style guide available. It is found in the
KDE User Interface Guidelines on the KDE Developer’s Corner page.

A short introduction to common GUI design principles can be found here.

C.6 Integrating Concepts and Tools — the IDE

There are separate tools available for almost any step in the programming pro-
cess—planning, editing, managing files and compilation processes, debugging,
documentation and the like. But once the projects grow the programming pro-
cesses will most likely become quite cumbersome.

Much repetitive work has to be done when designing, compiling, and debug-
ging a program. A lot of such work can be saved through the use of templates
and scripts. And another lot by keeping these tools easily available and able to
communicate with each other under a common GUI.

For example—would it not be convenient if a debugger were able to open the
source file in question in an editor and place the cursor directly at the position
of that bug just found?

To more easily accomplish such a scheme, Integrated Development Environments
(IDEs) were devised. Such an IDE integrates all templates, tools, and scripts
which are commonly needed in the development process into one single envi-
ronment.
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For the KDE platform KDevelop is such an IDE. It provides a wide range of
tools which ease program development and maintenance, even for different
programming languages and across platforms.

C.6.1 Basic Features of KDevelop 3.1.0

Manages all development tools needed for C++ programming, such as com-
piler, linker, debugger and build system.

Provides an Application Wizard which generates complete, ready-to-go sam-
ple applications.

Allows the user to select an integrated editor based on the KDE programmer’s
editor KWrite, Trolltec’s QEditor, or others.

A class generator, for creating new classes and integrating them into the cur-
rent project.

File management for sources, headers, documentation etc. to be included in
the project.

Assistance in creating application user manuals written with KDE tools.

Automatic HTML based API documentation for a project’s classes with cross-
references to the used libraries.

Internationalization support, allowing translators to add their target language
to a project easily, including support for KBabel.

Support for managing a project via one of several versioning systems (e.g.
CVS) by providing an easy-to-use frontend for the most needed functions.

An integrated debugger frontend.
An integrated shell console emulator.
Syntax highlighting in source texts.

An auto-code completion facility for class variables, class methods, function
arguments and more.

Templates for creating various projects (KControl modules, Kicker (panel) ap-
plets, KIOSlaves, Konqueror plugins and desktop styles).

Four navigation tree views for easily switching between source files, header

files, classes and documentation, obviating the need for an external file man-
ager.

Cross-compiling support, with the ability to specify different compilers, com-
piler flags, target architecture, etc.

Support for Qt/Embedded projects (such as the Zaurus and iPAQ).

Inclusion of any other program you need for development by adding it to the
Tools menu according to your individual needs.
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Appendix D

Configuration Files Used by
KDevelop

KDevelop uses a series of configuration files which are distributed amongst
several directories. There are two main groups of configuration files to distin-
guish:

KDevelop Default Configuration — files set up when KDevelop was installed.
User Oriented Configuration — files which contain user modifications of the defaults as well as settings ma

D.1 KDevelop Default Configuration

On installation, KDevelop writes some default information files for setup and
configuration purposes into subdirectories of the $KDEDIR installation directory
(usually something like /opt /kde, /usr/local/kde, or some other user-defined
installation directory, see Installing KDevelop).

D.1.1 Default KDevelop Configuration

There is only one KDevelop specific default configuration file in the $XKDEDI-
R/share/config/ directory:

kdeveloprec This file contains the basic settings KDevelop needs to start. It
will be copied to the user’s $KDEHOME/share/config directory when KDe-
velop does not find a kdeveloprec file there on startup.
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D.1.2 Application Specific Defaults

Most KDevelop features are provided by KParts. These are basically applica-
tions specially designed to run in the KDevelop framework (see the overview
in the Plugin Tools appendix). Each KPart application has its own set of con-
figuration files whose defaults will be stored in several subdirectories of the
$KDEDIR/share/apps/ installation directory.

There are quite a lot of default configuration subdirectories in $KDEDIR/share/apps/
whose names all start with a kdev sequence. Most of them are for KDevelop
internal use only. They might be deliberately grouped for readability as:

Stand-alone Applications
Task Specific Parts
Project Generation Parts
Language Specific Parts

e STAND-ALONE APPLICATIONS
- kdevelop/ — contains files to configure the KDevelop IDE:

* licenses/ — contains various licenses texts.

* pics/ — contains the picture files used for the KDevelop, KDevelop
Assistant, and KDevelop Designer splash screens.

* profiles/ — contains default plugin profile settings. (Currently there
is only a tiny profile provided which defines a minimum set of active
KDevelop plugins.)

% eventsrc — holds a lot of ‘Process successful” localization strings.

* kdevelopui.rc — provides the basic menu and tool bar entries KDe-
velop uses.

* kdevhtml_partui.rc — provides a Print... entry in the File menu, a
Copy entry in the Edit menu, and Back and Forward arrows in the
Browser Toolbar in case a HTML file is browsed from the Documen-
tation plugin.

— kdevassistant/ — provides the menu and tool bars of the stand-alone

KDevelop Assistant documentation browser.

— kdevdesigner/ and kdevdesignerpart/ — provide menu bar and tool bars
of the stand-alone KDevelop user interface designer.

e TASK SPECIFIC PARTS

- kdevabbrev/ — contains files used by the Abbreviation Expansion plugin:

* sources/ — contains keyword definition files used by the Expand Text
command.

* templates/ — contains template definition files used by the Expand Ab-
breviation command.

* kdevabbrev.rc — provides the Expand Text and Expand Abbreviation
entries in the Edit menu.

- kdevappwizard/ — contains files used by the Application Wizard part:
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* importfiles/ — contains .kdevelop project files which control the ini-
tialization of a new project.

* imports/ — contains templates to set up project specific .desktop files.

* template-common/ — contains various files commonly included in the
project source directories.

* templates/ — contains configuration files which describe the informa-
tion to be included in a given project source directory.

* *.png — project preview images used by the Application Wizard.

% *.tar.gz — tarballs containing the source files to be included in a new
generated project directory.

kdevastyle/ — provides the Reformat Source entry in the Edit menu.

kdevautoproject/ — provides most of the entries in the Build menu and
the Build Toolbar (KDevelop) toolbar.

kdevclassview/ — contains files used by the Class View project plugin:

* pics/ — contains the icons used in the Classes classview tree.

* kdevclassview.tc — provides the Class Inheritance Diagram entry in
the Projects menu as well as the classes navigation combo box in the
Browser Toolbar.

kdevcloser/ — provides the Windows menu close entries.
kdevctags/ — provides the CTags entry in the Tools menu for the CTags
Frontend project plugin.

kdevcvsservice/ — provides the icon used by the CvsService tab and a
short shell script used to add a new entry to the CVS repository, both used
by the CVS Integration project plugin.

kdevdebugger/ — provides the Debug menu entries for the Debugger Fron-
tend project plugin.
kdevdiff/ — provides the Difference Viewer entry in the Tools menu.

kdevdistpart/ — provides the Distribution & Publishing entry in the Project
menu for the Final Packaging Support project plugin.

kdevdocumentation/ — contains files used by the Documentation plugin:

* en/ and pics/ — contain files used by the htdig search tool.

* tocs/ — contain the default KDevelop documentation content descrip-
tion files (see the description in Basic Structure of KDevelop TOC Files).

* kdevpart_documentation.rc — provides the search related entries in
the Help menu.

kdevdoxygen/ — provides the menu entries for the Doxygen Support project

plugin.

kdevfilecreate/ — contains files used by the New File Wizard:

* file-templates/ — provides the initial text contents to be put into the
new source file of a given type.

* kdevpart_filecreate.rc — provides the New entry in the File menu.

* template-info.xml — contains descriptions of the available file types
to be displayed in the New File tool view.
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kdevfilter/ — provides the Execute Command... and Filter Selection
Through Command... entries in the Tools menu used by the Shell Filtering
and Insertion plugin.

kdevfullscreen/ — provides the Full Screen Mode entry in the View menu
and the according tool bar icon.

kdevgrepview/ — provides the Find in Files... entry in the Edit menu used
by the Grep Frontend plugin.

kdevhistory/ — provides the Back and Forward entries in the View menu.

kdevjavadebugger/ — provides a Java Debug menu in order to debug a
Java™ application.

kdevoutputviews/ — provides the Next Error and Previous Error entries
in the View menu.

kdevpartexplorer/ — provides the Part Explorer entry in the Tools menu
used by the Part Explorer Tool plugin.

kdevquickopen/ — provides the Quick Open File... entry in the File menu
and the Quick Open Class... and Quick Open Method entries in the Tools
menu used by the Quick Open project plugin.

kdevregexptest/ — provides the Debug Regular Expression... entry in the
Tools menu used by the Regular Expression Tester plugin.

kdevreplace/ — provides the Find-Select-Replace... entry in the Edit menu
used by the Replace Part plugin.

kdevtipofday/ — provides the Tip of the Day entry in the Help menu as
well as a HTML-File containing the available tips.

kdevtools/ — controls various menu entries created by Tools Menu and
External Tools Menu settings provided by the Tools Menu Addition plu-
gin.

kdevvalgrind/ — provides the Valgrind Memory Leak Check and Profile
with KCachegrind entries in the Debug menu used by the Valgrind Fron-
tend plugin.

e PROJECT GENERATION PARTS

kdevadaproject/ — provides entries for the Build menu and according
tool bar icons to build an Ada application.

kdevantproject/ — provides entries for the Build menu when the Ant
project generator is used.

kdevautoproject/ — provides entries for the Build menu and according
tool bar icons when working with the GNU Tools based automake project
generator. Additionally provides the Add Translation and Build Configu-
ration entries to the Project menu.

kdevcustomproject/ — provides entries for the Build menu and according
tool bar icons when the project is based on custom Makefils.

kdevgenericproject/ — contains menu definitions for an experimental
generic project generator. Currently (version 3.1.0) unused.
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- kdevhaskellproject/ — provides entries for the Build menu and accord-
ing tool bar icons to build a Haskell application.

— kdevpascalproject/ — provides entries for the Build menu and according
tool bar icons to build a Pascal application.

— kdevtrollproject/ — provides entries for the Build menu and according
tool bar icons to build an application using the Qt™ QMake project man-
ager.

LANGUAGE SPECIFIC PARTS

— kdevadasupport/ — provides entries in the Tools menu and according tool
bar icons needed to develop Ada applications.
— kdevbashsupport/ — provides entries in the Build menu and according
tool bar icons needed to develop Bash scripts.
— kdevcppsupport/ — contains files used by the Application Wizard to build
C++ applications:
* newclass/ — contains header and source templates from which the Ap-
plication Wizard builds the according source files.
* subclassing/ — contains templates which the Application Wizard uses
to set up initial class declarations/definitions in the source files.
* templates — contains templates from which the Application Wizard
sets up the default header and source template files to be used by the

New File Wizard.
* configuration — dummy template to add macros.

% kdevcppsupport.rc — provides the Complete Text and Make Member
entries fo the Edit menu, the Switch Header/Implementation entry for
the View menu, and the New Class entry for the Project menu as well as
a New Class icon for the Browser Toolbar.

— kdevfortransupport/ — provides entries in the Build menu needed to de-
velop Fortran applications.

— kdevhaskellsupport/ — provides entries in the Build menu and accord-
ing tool bar icons needed to develop Haskell applications.

- kdevjavasupport/ — contains the UI definition needed to develop Java™

applications.

— kdevpascalsupport/ — contains the Ul definition needed to develop Pas-
cal applications.

— kdevperlsupport/ — provides Project and Help menu entries needed to
develop Perl scripts.

— kdevphpsupport/ — contains UI and PHP function definition files needed
to develop PHP scripts.

— kdevpythonsupport/ — provides Build and Help menu entries and ac-
cording tool bar icons needed to develop Python scripts.

— kdevrubysupport/ — provides Build menu entries and according tool bar
icons needed to develop Ruby scripts.

— kdevscriptproject/ — provides the Ul definitions needed to develop
custom projects. Currently (version 3.1.0) unused.

- kdevsglsupport/ — provides the Ul definitions needed to develop SQL
projects. Currently (version 3.1.0) unused.
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D.2 User Oriented Configuration

All information about user defined settings is kept in two subdirectories of $K-
DEHOME, namely:

Application Specific Configuration in the SKDEHOME/share/apps/ directory, and
Resource Configuration File in the $SKDEHOME/share/config/ directory.

D.2.1 Application Specific Configuration

Any user changes to the KDevelop Default Configuration settings as well as
user specific settings which are not kept in any of the Resource Configuration

Files are found in kdev. .. subdirectories of the SKDEHOME/share/apps/ direc-
tory.

Most of these configuration files are however used by various KDevelop plug-
ins in order to provide some specific menu and/or toolbar entries. Thus they
are of interest only in case something went really wrong with the user interface.

NOTE

In case the contents of these directories mirror those of the Default Configuration
settings, KDevelop will have copied them from $SKDEDIR/apps/ into the $SKDEHOM-
E/apps/ directory on its initial start. Any subsequent changes will be made to these
copies only. The Default Configuration settings remain unchanged in any case.

e kdevabbrev/ — contains files used by the Abbreviation Expansion plugin:
- sources/ — currently empty; KDevelop uses the default keyword defini-
tion files for Expand Text commands.

— templates/— contains the user modified template definition files used by
the Expand Abbreviation command.

— kdevabbrev.rc — provides the Expand Text and Expand Abbreviation en-
tries in the Edit menu.

e kdevappwizard/ — only provides the New Project... and Import Existing
Project... entries in the Projects menu. The Application Wizard will use the
default configuration settings for its actual works.

e kdevastyle/ — provides the actual Reformat Source entry in the Edit menu.

e kdevautoproject/ — provides the actual entries in the Build menu and the
Build Toolbar (KDevelop) toolbar.

e kdevclassview/ — provides the Class Inheritance Diagram entry in the Project
menu and the class browser combo box in the Browser Toolbar by the Class
View project plugin.
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e kdevcloser/ — provides the Close Selected Windows... entry in the Win-
dows menu.

e kdevcppsupport/ — holds the actual configuration used by the Application
Wizard to build C++ applications. The Application Wizard however uses its
main bulk of configuration information directly from the default configura-
tion directory. See there for more detail.

- newclass/ — contains the actual header and source templates from which
the Application Wizard builds the according source files.

- pcs/ — contains database files KDevelop uses build the actual Persistent
Code Store (. pcs) file of a KDE C++ project.

— kdevcppsupport . rc — provides the Complete Text and Make Member en-
tries fo the Edit menu, the Switch Header/Implementation entry for the
View menu, and the New Class entry for the Project menu as well as a
New Class icon for the Browser Toolbar.

e kdevctags/ — provides the CTags entry in the Tools menu for the CTags
Frontend project plugin.

e kdevdebugger/ — provides the Debug menu entries for the Debugger Fron-
tend project plugin.

e kdevdiff/ — provides the Difference Viewer entry in the Tools menu.
e kdevdocumentation/ — contains the actual files used by the Documentation
plugin in addition to the default configuration files. See there for more detail.

The directories in kdevdocumentation/ mainly hold actual bookkeeping in-
formation. The actually set up documentation files are kept in doc...pluginrc
files in the $KDEHOME/share/config/ directory.

— bookmarks/ — maintains the entries in the Bookmarks tab of the KDevelop
Documentation plugin.

— index/ — holds various cache files KDevelop uses to speed up indexed
documentation searches in the Index tab of the Documentation plugin.

- search/ — contains files used by the htdig search tool which serves search
calls from the Search tab of the Documentation plugin.

— kdevpart_documentation.rc — provides the search related entries in the
Help menu.
e kdevdoxygen/ — provides the menu entries for the Doxygen Support project
plugin.
e kdevelop/ — contains some actual settings KDevelop uses for its basic setup:

- profiles/ — provides actual plugin profile setting. (Initially there is only
a FullIDE profile which defines a full set of initially active KDevelop plu-

gins.)

— kdevelopui.rc — provides the basic menu and tool bar entries KDevelop
uses.

125



KDevelop User Manual

e kdevfilecreate/ — contains files used by the New File Wizard:

- file-templates/ — provides the actually used text contents to be put into
the new source file of a given type. More file templates are found in the
default configuration files directory.

- kdevpart_filecreate.rc — provides the New entry in the File menu.

- template-info.xml — contains descriptions of the available file types to
be displayed in the New File tool view.

e kdevfilter/— provides the Execute Command... and Filter Selection Through
Command... entries in the Tools menu used by the Shell Filtering and Inser-
tion plugin.

e kdevfullscreen/ — provides the Full Screen Mode entry in the View menu
and the according tool bar icon.

e kdevgrepview/ — provides the Find in Files...entry in the Edit menu used by
the Grep Frontend plugin.

e kdevoutputviews/ — provides the Next Error and Previous Error entries in
the View menu.

e kdevpartexplorer/ — provides the Part Explorer entry in the Tools menu
used by the Part Explorer Tool plugin.

e kdevquickopen/ — provides the Quick Open File.. entry in the File menu
and the Quick Open Class... and Quick Open Method entries in the Tools
menu used by the Quick Open project plugin.

e kdevregexptest/ — provides the Debug Regular Expression... entry in the
Tools menu used by the Regular Expression Tester plugin.

e kdevreplace/ — provides the Find-Select-Replace... entry in the Edit menu
used by the Replace Part plugin.

e kdevtipofday/ —provides the Tip of the Day entry in the Help menu. The
HTML-File containing the available tips is provided as a default configura-
tion file only.

e kdevtools/ — controls various menu entries ceated by Tools Menu and Ex-
ternal Tools Menu settings provided by the Tools Menu Addition plugin.

e kdevvalgrind/ — provides the Valgrind Memory Leak Check and Profile
with KCachegrind entries in the Debug menu used by the Valgrind Frontend
plugin.

D.2.2 Resource Configuration Files

There are two groups of KDevelop configuration files in the $KDEHOME/ share/config/
directory, distiguished by their surrounding character sequences:
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‘doc. . .pluginrc’ denotes files used by the documentation plugin.
‘kdev. ..rc’ denotes configuration files used by KDevelop itself and its available plugins.

CONFIGURATION FILES USED BY KDEVELOP

e kdevabbrevrc — holds the current state of the Abbreviations configuration
provided by the Abbreviation Expansion plugin.

NOTE

This only records whether the abbreviations will be used or not. The
actual definitions of new abbreviations will go into the S$KDEHOM-
E/share/apps/kdevabbrev/templates/templates file.

e kdevassistantrc — holds some configuration states specific of the stand-
alone KDevelop Assistant documentation browser.

NOTE
Most common configuration settings are shared with the KDevelop IDE kdevel-
oprc file.

e kdevassistantuimode4rc —holds the current MDI configuration states (dock
positions etc.) of the stand-alone KDevelop Assistant documentation browser.

e kdevclassviewrc —holds the View Mode setting of the Classes class browser
tab provided by the Class View project plugin.

NOTE

This is a global setting, although the Class View plugin may be disabled on a per
project basis. Any change in this setting will be globally updated whenever the
current project is closed and thus affect all subsequently loaded projects.

e kdevcppsupportrc — holds some settings used to set up CPP source files.
In particular you will find the settings made on the C++ Class Generator
configuration dialog in here.

e kdevdocumentationrc — holds actual settings the Documentation plugin uses.

e kdeveloprc — holds the global settings the KDevelop IDE and the KDevelop
Assistant stand-alone documentation browser will use.

e kdevelopuimoded4rc — holds the current MDI configuration states (dock po-
sitions etc.) of the KDevelop IDE.

e kdevfileselectorrc — holds actual settings the File Selector plugin uses.

e kdevfileviewrc — holds the actual filename color settings the CVS Integra-
tion (Cervisia) project plugin uses for display.

e kdevfilterrc—holds actual settings the Shell Filtering and Insertion plugin
uses.
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e kdevgrepviewrc — holds actual settings the Grep Frontend plugin uses.
e kdevsnippetrc — holds actual settings the Code Snippets plugin uses.

e kdevtoolsrc — holds actual settings the Tools Menu Addition plugin uses.

CONFIGURATION FILES USED BY THE DOCUMENTATION PLUGIN

e docchmpluginrc — holds information about the actual Microsoft® CHM
help files as defined on the CHM Documentation Collection configuration
page.

e doccustompluginrc — holds information about any custom documentation
file defined on the Custom Documentation Collection configuration page.

e docdevhelppluginrc — holds information about the actual GNOME 2 De-
vHelp documentation files as defined on the Devhelp Documentation Col-

lection configuration page.

e docdoxygenpluginrc — holds information about the actual Doxygen gener-
ated API documentations as defined on the Doxygen Documentation Collec-
tion configuration page.

e dockdevtocpluginre — holds information about the actual KDevelopTOC
structured documentation files as defined on the KDevelopTOC Documen-
tation Collection configuration page.

e docgtpluginrc — holds information about the QT documentation files actu-
ally included on the Qt Documentation Collection configuration page.

D.3 Project Dependent Configuration

Most project-dependent configuration is kept in the <project-name>.kdevelop
and <project-name>.kdevses KDevelop project configuration files rather than
in separate files as the other, more global, configuration settings. In short, those
files are meant for:

<project-name>.kdevelop — global project configuration information.
<project-name>.kdevses — configuration information needed to restore the specific behaviours of the runr

Both are XML coded files. They can be viewed and (cautiously) altered using
any text editor.

D.3.1 Persistent Code Store Files

There is a third project-dependent configuration file, the <project-name>.kde-
velop.pcs Persistent Code Store. This is a binary coded file holding an internal
parser cache for the most part in order to speed up the loading sequence of the
project. Additionally, this Persistent Code Store keeps information use by the
Code Completion facility of KDevelop.
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NOTE

There can be additional Persistent Code Store files be set up on the
Code Completion tab of the C++ Specific project configuration page. In-
formation about these additional .pcs is kept globally in the S$KDEHOM-
E/share/apps/kdevcppsupport/pcs/ directory.
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Appendix E

Plugin Tools

KDevelop contains a large number of little tools that help you to perform cer-
tain task. Most of them are realized as plugins. That means, if you do not need
a plugin, you can disable it.

That also means, if you are looking for a functionality that should be there and
isn’t, then maybe it’s implemented in a plugin and that plugin is disabled. For
example, in the file menu there is a Quick Open feature, but only if it’s enabled
in the Project - Project Options dialog.

Technically, plugins are based on the KDevPlugin class defined in lib/inter-
faces/kdevplugin.h. The following is taken from a comment from there.

KDevPlugin is the base class for all KDevelop plugins. A plugin is a compo-
nent which is loaded into KDevelop shell at startup or by request. A plugin
has a scope that can be either:

e Core
e Global

e Project

Core plugins are global plugins which offer some important "core" functional-
ity and thus are not selectable by user in plugin configuration pages.

Global plugins are plugins which require only shell to be loaded and do not
operate on KDevProject interface and/or do not use project wide information.
For example, the uimode plugin allows a developer to select which user inter-
face they wish to use.

Project plugins require a project to be loaded and are usually loaded /unloaded
along with the project. If a plugin operates on project-related information then
it is a project plugin. The Automake Manager, for example, only needs to be
active when an Automake based project is currently loaded.
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As stated above, core plugins cannot be disabled. Global plugins can be en-
abled/disabled in Settings — Configure KDevelop... under Plugins. Project
plugins can be enabled/disabled in Project — Project Options... under Plug-
ins. Active plugins can have many effects on KDevelop. Depending on their
function, they may add extra menus, extra menu items, extra tool buttons, etc.

Plugins which are disabled do not clutter your menus and are not loaded into
memory.

The following plugin list is generated by a small script (listplugins.sh) written
by Volker Paul. All plugins have a .desktop file where information such as
name and comments are written. If in the following these comments are not
very useful, it is because the plugin authors made them this way:.

The plugins are grouped by scope (Core, Global, Project).

Scope: Core

Application Wizard Application Wizard

Difference Viewer Difference Viewer
FileCreate FileCreate

FullScreen FullScreen

Tip of the Day Tip of the Day

User-Interface Selection Provides a dialog for UI-mode selection.

VCSManager Version Control System Manager

Scope: Global

Abbreviation Expansion Provides support for customizable abbreviations -
short words which expand into commonly needed code structures.

Documentation The Documentation plugin offers browsing and searching
in local and online documentation with support for multiple documentation
systems.

FileList Provides a list of all currently open files. (Handy when the tab bar
is not quite wide enough.)

File Selector Powerful network transparent file browser utility.

Shell Filtering and Insertion Provides a way of manipulating editor text
using commandline tools. Appears in the Tools menu.

Grep Frontend Integrates "find | grep" in KDevelop - allows fast searching of
multiple files using patterns or regular expressions.

Embedded Konsole This plugin gives KDevelop an embedded konsole for
quick and easy command line access.
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"Open with" Menu Addon This plugin provides additional "open" alterna-
tives for various context menus in KDevelop.

Part Explorer Tool A Graphical tool for performing KTrader-like queries
about registered services

Regular Expression Tester Tool to design and test regular expressions against
common regexp syntaxes.

Replace Part This plugin is an interactive projectwide "Search and Replace"
tool. Search using string or regexp matching, and select the replacements
to be made from a preview before the action is finalized. When loaded it
appears in the Edit menu.

Scripting The Scripting plugin offers KScript based scripting of the KDe-
velop application

Code Snippets This plugin allows you to store code snippets and add them
to your code

Text Structure Provides a structure overview and navigation for HTML and
TEX files

Tools Menu Addition This plugin provides an easy way to add external
applications to the Tools menu and toolbar.

Valgrind Frontend Valgrind is a tool that helps you find memory manage-
ment problems in programs. http://developer.kde.org/ sewardj/

Scope: Project

annotation Plugin annotation Description

Source Code Formatter A plugin for formatting of sourcecode according to
a specified set of rules. When loaded it is found in the Tools menu.

Bookmarks Plugin that provides navigation and overview of active source
bookmarks and persists them between sessions.

Class View This plugin displays a graphical view of all the classes in the
project, complete with methods and attributes, and provides a way of direct
source navigation.

CopyTo Simple file uploader plugin. It does a file copy over any KIO sup-
ported protocol.

CTags Frontend CTags is a source navigation tool with support for many
languages. When loaded it provides a context menu for finding type decla-
rations/definitions and also a query dialog. http://ctags.sourceforge.net/

Final Packaging Support Aids in building and publishing the final project.
Only RPM package format is supported for now.
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Doxygen Support The doxygen plugin provides a way to specify and control
generation of documentation for a project, based on source code content.
You need to have doxygen installed to be able to use this. For more info goto
http:/ /www.doxygen.org

QuickOpen Provides an efficient way of finding/opening files, classes and
methods in a large project. Appears in the File and Tools menus when
loaded.

Security Checker Code security checker

So far the generated plugin list.

. ANT Project Manager (Java™
antproject -
applications)
autoproject Automake Project Manager
customproject Custom Project Manager
trollproject (QMake based Project Manager

Table E.2: Project Management Plugins in KDevelop

The above plugins are currently (May 2005) empty. Maybe project manage-
ment support will be implemented as plugins in the future.

cppsupport Support for C/C++
fortransupport Support for Fortran
javasupport Support for Java™
perlsupport Support for Perl
phpsupport Support for PHP
pythonsupport Support for Python

Table E.4: Language Support Plugins in KDevelop

In the following, some of the plugins will be discussed in detail.

e The abbrev Plugin This plugin expands abbreviations into frequently used
code snippets. It is activated by pressing Ctrl+Space. For example, when
you enter "ife" into a C++ in the editor and press Ctrl+Space, you obtain
an if-else code template and save some key strokes. The set of supported
abbreviations depends on the programming language of the edited file. For
example, for PHP you will obviously be interested in other code templates
than for Java™.,
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The set of code templates is configurable. If the plugin is enabled, you can
see which ones are available in the Settings — Configure KDevelop... dialog
under Abbreviations.

The filter Plugin This offers two features. If you select Tools — Execute com-
mand, you can enter a shell command. The output of this command is in-
serted into the editor buffer when you hit the Start button.

A related feature is available under Tools — Filter selection through com-
mand.... In order to use this, you must select a text area in the editor. If you
now enter a shell command and hit the Start button, the command is started
and the selection used as the standard input for it. The standard output of
the command is then inserted into the editor, replacing the selection.

For example, if you write documentation, you frequently have to refer to
menu items. To do this correctly for e.g. the Copy command in the Edit
menu, you have to write:

<menuchoice><guimenu>Edit </guimenu><guimenuitem>Copy</ <
guimenuitem></menuchoice>

This is cumbersome, so you'd rather just write "Edit - Copy" and let the com-
puter do the tagging. Here is how you can do it. You write a little shell script
called mef you put e.g. in your home’s bin directory:

sed s/"*\(.*\) - \(.*\)\$"/"<menuchoice><guimenu>\1<\/ «
guimenu><guimenuitem>\2<\/guimenuitem><\/menuchoice>"/

Don’t forget to make it executable. That’s all. Now, in your documentation
.docbook source, you write "Edit - Copy". You select this text you just wrote,
choose Tools — Filter selection through command... and call /bin/mef. In-
stantly "Edit - Copy" is replaced by

<menuchoice><guimenu>Edit </guimenu><guimenuitem>Copy</
guimenuitem></menuchoice>

The Doxygen Plugin This one helps you to use the Doxygen API documen-
tation tool (http://www.doxygen.org). You can select Project — Run Doxy-
gen to generate APl documentation for your current project, based on the
configuration given by the file Doxyfile in your project directory.

Furthermore, you can configure Doxygen in the Project — Project options...
dialog. This dialog is very similar to the doxywizard tool.

The ctags Plugin Although the class browser gives you extensive insight
into the symbols and classes of your project, you may also want to use the
ctags tool. In particular, this one supports a lot more language than the class
browser.

You activate this plugin under Tools — CTags.... When you start it the first
time, you will be asked to generate a search database first. When you accept
this, the ctags program will be started and will create a file named tags in
your project directory. This is a text file containing all symbols of your source
files.
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You can search in the symbol database in two ways: when the Regular ex-
pression match box is checked, the text you enter will be interpreted as a
regular expression (POSIX flavor) and matched with the existing symbols.
For example, the text . *Widget will search for all symbols ending with wWid-
get. If the box is not checked, the search will be verbatim.

When searching, you will get a list of the matched symbols, accompanied
with the line numbers where they are defined. You jump to the respective
point by clicking on the list.

For some languages, ctags distinguishes different kinds of symbols. For ex-
ample, Python has classes and functions. You can selectively search only for
classes by checking the respecting kinds in the dialog.

The symbol database is normally not updated when your sources change.
Consequently, after a while the line numbers will not be correct anymore and
newly added classes and functions will be missing. Therefore you should
update the tags file in regular intervals by pressing the button Regenerate.

The astyle Plugin Astyle is a plugin for formatting of sourcecode according
to a specified set of rules.

The regexptest Plugin Designing with regular expressions can be hard work.
Often the first try at an expression matches too many strings. In particular,
when working with a compiled language, the turnaround times when de-
bugging a regular expression can be awkward. The regexptest plugin allows
you to directly explore the changes in a regular expression. It is activated by
choosing Tools — Debug Regular Expression....

In the flavor group box, you can choose the flavor of the regular expression
engine used. Currently supported is the flavor defined in the POSIX stan-
dard, which is used by the grep program, and the extended POSIX syntax
used by the program egrep.

When you enter an expression, you get immediate feedback about any syn-
tax errors in it. By entering a text under Test string, you can see whether
the expression matches this string. In particular, if your regular expression
includes groups, such as ([a-z]), the content of the matched subgroups will
be shown in a list box.
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Appendix F

KDevelop User Interface
Mode Examples

E1 IDEAIl Mode

Click here to return to the modes overview.
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}
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}
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KDevelop IDEAI mode

Click here to return to the modes overview.
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A
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rnainwindow *Mainwindow::main ()
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El T return this;
1
IS |
void Mainwindow::createstatusear ()
k@ ¢
(void) new starusear (this);
1
void Mainwindow::createFramework()
{
Partcontroller::createlnstance (this) ;
setMenuForsblModesysEuttons (menuear () ) ;
1
void Mainwindow::createactions ()
{
wviewnenuactionprivateData viewactionData; iewactionpaca ho. the 7y
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KDevelop IDEAI mode, closed tabs

This example screenshot demonstrates one of the main virtues of IDEAl mode.
There is a maximum workspace available. Yet any tool view is readily available
by clicking on the according tab.

You will most probably need some time to get accustomed to the icons in the
tab bar. If you got lost, just position the mouse over a tab and wait a few
seconds. A short tool tip description will pop up. In this screenshot the ‘Au-
tomake Manager’ tool tip is shown as an example. It describes the lower tab in
the right tab bar.

Click here to return to the modes overview.

E2 Child Frame Windows Mode

Click here to return to the modes overview.
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KDevelop child frame windows mode

Click here to return to the modes overview.

E3 Tabbed Pages Mode

Click here to return to the modes overview.
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KDevelop tabbed pages mode

Click here to return to the modes overview.

F4 Toplevel Windows Mode

Click here to return to the modes overview.
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Appendix G

Command Reference

NOTE
The shortcut key combinations shown in this chapter are the default ones. They
can be changed.

G.1 The Menubar

Note that some menu entries only appear when they are applicable. Especially,
some entries are linked to plugin functionality which is only available when the
plugin is enabled.

G.1.1 The File Menu

File — New (Ctrl+N) Creates a new file. The user is prompted to select the
directory (default: the current project’s source directory) and enter a file
name. The file type can be selected from a list. Also, the user can choose
whether the file is to be added to the project. Then the Automake Man-
ager asks which target to add the new file to.

File — Open (Ctrl+O) Opens an existing file in a simple dialog box.

File — Open Recent For opening the most recently edited files. Once you
have clicked on this option, a list of recently edited files will appear. Se-
lect the file you want and KWord will open the file.

File — Quick Open File (Alt+Ctrl+O) Presents a list of files in the current project’s
source directory. The user can select from this list or type a filename. That
file is then opened.

141



KDevelop User Manual

File — Save (Ctrl+S) Saves the current file.

File — Save As... Uses the Save As... dialog box to let you save a copy under
anew name.

File — Save All Saves all open files.

File — Reload (F5) Reloads current file to show changes made by different
programs. (Note that such changes are normally detected automatically
and the user is prompted whether the file is to be reloaded.) .

File — Revert all Reverts all changes in opened files. Prompts to save changes
so the reversion can be canceled for each modified file.

File — Print... (Ctrl+P) Prints the current file.

File — Export Exports the current file. Currently the following export formats
are supported:

HTML Syntax-highlighted HTML file
Other formats may follow in future KDevelop versions.

File — Close (Ctrl+F4) Closes current file.
File — Close All Closes all open files.

File — Close All Others Closes all files except the current one. Very useful if
you opened a lot of files and you want to concentrate on the current one.

Without this, you would have to close them all and re-open the current
one.

Note there is a similar command in the Window menu.
File — Quit (Ctrl+Q) Quits KDevelop.

G.1.2 The Edit Menu

NOTE
Most of the following commands operate on the current file, also simply called "doc-
ument".

Edit — Undo (Ctrl+Z) Reverses the last action you performed.
Edit — Redo (Ctrl+Shift+Z) Reverses the last Undo performed.

Edit — Cut (Ctrl+X) Deletes the selected (highlighted) text from the document,
and places a copy in the clipboard.

Edit — Copy (Ctrl+C) Places a copy of the selected text in the clipboard.
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Edit — Paste (Ctrl+V) Inserts a copy of the clipboard into the current cursor
position. If there is selected text, KDevelop replaces it with the contents
of the clipboard. The clipboard is not altered.

Edit — Select All (Ctrl+A) Immediately selects all text of the current file.

Edit — Deselect (Ctrl+Shift+A) Every simple cursor movement (e.g. left, right
etc. without Shift pressed) deselects at the same time, i.e. if there was
highlighted text before, after the cursor action it will appear non-highlighted
again. This command does an explicit Deselect without cursor action.

Edit — Block Selection Mode (Ctrl+Shift+B) KDevelop’s editor can operate
linewise or block-oriented. Linewise means: Text is seen as a sequence of
characters that may span several lines. A selection ranges from the first
to the last character and includes all lines in-between completely.

Block-oriented means: Text is seen as a rectangular matrix. You can select
a rectangular block (called rectangle in (X)Emacs) that leaves out the be-
ginnings and ends of all lines. The commands Cut and Copy then operate
only on that block, and place it in the clipboard.

Thus you can e.g. indent all lines of a block: Select the block, Cut it, then
place the cursor in the first line at the beginning of the area you want to
put the block, e.g. 3 characters to the right of the old position. There,
Paste it, and all lines will be indented.

This would be very useful if it honored the overwrite flag (e.g. block
comment). It doesn’t, and I see this as a bug. TODO: - report bug - work
out more examples how block mode is useful (extra chapter?) - links to
alternate methods (for indent: Edit - Reformat Source, comment)

Edit — Overwrite Mode (Insert) Toggles Insert/Overwrite Mode.

Edit — Find (Ctrl+F) Calls the Find dialog box. You can search simple text or
a regular expression.

Edit — Find Next (F3) After first using Find (see above), finds the same text or
regular expression again.

Edit — Find Previous (Shift+F3) After first using Find (see above), finds the
same text or regular expression again, searching upwards.

Edit — Replace (Ctrl+R) Opens the Find/Replace dialog box. You can search
simple text or a regular expression. You can replace by simple text or
placeholders of the regular expression.

Edit — Go to Line (Ctrl+G) Prompts for a line number and jumps to that line.

2{0u ;:an show /hide line numbers with View - Show /Hide Line Numbers
F11).

Edit — Find in Files (Alt+Ctrl+F) Finds text in several Files, like the grep Unix
command. Matches will be displayed, and you can switch to a match di-
rectly. TODO!!!
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Edit — Find-Select-Replace (Ctrl+Shift+R) Opens the project wide string re-
placement dialog. There you can enter a string or a regular expression
which is then searched for within all files in the locations you specify.
Matches will be displayed in the Replace window, you can replace them
with the specified string, exclude them from replace operation or cancel
the whole replace.

Edit — Reformat Source Reformats Source code using the astyle library. If
there is a selection, only the selection will be formatted. Otherwise the
entire file will be formatted.

Edit — Expand Text (Ctrl+]) A list of reasonable completions of the current
word is presented, the user can select one of them, and this is then placed
in the text. For example, if the user has typed "whi" and calls this com-
mand, "while" and "while () { }" are offered. If the user selects the lat-
ter, the whole structure of a while command is entered and the cursor is
placed in the brackets to enter the condition. TODO: BUG: Ctrl-] doesn’t
work

Edit — Expand Abbreviation (Ctrl+L) Expands abbreviation. Abbreviations
can be defined in Settings - Configure KDevelop - Abbreviations.

Edit — Complete Text (Ctrl+Space) Completes current expression using mem-
ory class store for the current project and persistent class stores for exter-
nal libraries. TODO

Edit — Make Member (F2) Creates a class member function in implementa-
tion file based on the member declaration at the current line. TODO

G.1.3 The View Menu

View — Back Moves back in the list of tabs.
View — Forward Moves forward in the list of tabs.

View — Switch to... (Ctrl+/) Presents a dialog box to select a tab buffer an
moves there.

View — Raise Editor (Alt+C) Places the focus on the editor.

View — Next Error (F4) Switches to the file and line the next (compilation) er-
ror was reported from.

View — Previous Error (Shift+F4) Switches to the file and line the previous
(compilation) error was reported from.

View — Full Screen Mode (Shift+F) In normal mode: Switches to Full Screen
Mode. Only KDevelop’s window will be shown, without the frame.

In Full Screen Mode: Switches back to normal mode. Other windows will
be visible again, KDevelop’s window gets its frame again.

View — Switch Header/Implementation (Ctrl+F12) When in a C++implemen-
tation file, switches to the corresponding header file, and vice versa.
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View — Tool Views Puts the focus on one of KDevelop’s various tools resp. its
output. Switch back to the editor with the View - Raise editor command
above.

View — Tool Docks KDevelop’s GUI has a Top, Bottom, Left and Right Tool
Dock. With this command, you can select and switch to any of them.

View — Switch to Command Line (F7) KDevelop uses Katepart as editor. Katepart
has a command line to enter editing commands directly. This menu item
switches to the Katepart Command Line. For a list of available editing
commands, enter help list here.

View — Schema Schema TODO ???

View — Dynamic Word Wrap (F10) Switches Dynamic Word Wrap on and off.
If it is on, then lines that don’t fit on the screen will be broken and con-
tinued on the next line.

View — Dynamic Word Wrap Indicators Selects Dynamic Word Wrap Indica-
tors option:

Off Indicators (folded arrows in the line number border) are not dis-
played

Follow line numbers If line numbers (see command below) are displayed
(in the line number border), then Dynamic Word Wrap Indicators
are displayed as well

Always On Dynamic Word Wrap Indicators are always displayed, which
causes the border to be present

View — Show/Hide Static Word Wrap Marker Shows/Hides the Static Word
Wrap Marker, a vertical line drawn at the word wrap column as defined
in Settings - Configure Editor - Editing - Static Word Wrap. (TODO: Bug;:
the line is not shown. Static word wrap works for newly changed lines)

View — Show/Hide Icon Border (F6) Shows/Hides the Icon Border which is
used to show e.g. bookmark and breakpoint symbols.

View — Show/Hide Line Numbers (F11) Show/Hide Line Numbers on the
left side, in the line number border. This may also cause dynamic word

wrap markers to be displayed, see above.

View — Show/Hide Scrollbar Marks Show /Hide Scrollbar Marks. TODO: No
effect, bug?

View — Show/Hide Folding Marks (F9) Shows/Hides Folding Marks in the
left border. Note that code folding (see below) can be used even if the
marks are not shown.

View — Code Folding Code folding is used to easily gain an overview of the
code by collapsing blocks so they are shown as just the top line. The
commands in this submenu collapse or expand the local or top level.

Collapse Toplevel (Ctrl+Shift+-) Collapses toplevel.
Expand Toplevel (Ctrl+Shift++) Expands toplevel.
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Collapse One Local Level (Ctrl+-) Collapses innermost local level.
Expand One Local Level (Ctrl++) Expands innermost local level.

View — Set Encoding In former KDevelop versions the Set Encoding function
now in the Tools menu used to be here.

G.1.4 The Project Menu

Project — New Project... This starts KDevelop’s application wizard. It helps
you to generate a skeleton for your application from a set of templates.

Project — Open Project... Opens a Kdevelop2 or KDevelop3 project.

Project — Open Recent Project Opens recently edited project. A submenu of
recently edited projects is displayed to choose from.

Project — Import existing Project... Creates a KDevelop project file for a given
directory, where already existing code files of a non-KDevelop project are
stored.

Project — New Class... Calls the New Class wizard.

Project — Class Inheritance Diagram Displays inheritance relationship between
classes in the project.

NOTE
This does not display classes outside inheritance hierarchy.

Project — Add Translation... Prompts the user for a language and creates .po
file for the selected language.

Project — Build Configuration ???TODO

Project — Distribution & Publishing Opens the Project Distribution & Pub-
lishing dialog which helps users package and publish their software.
TODO:link

Project — Project Options... Opens dialog to set project options.

Project — Close Project Closes current project.

G.1.5 The Build Menu

Build — Build Project (F8) Runs make from the project directory.

Build — Build Active Target (F7) Constructs a series of make commands to
build an active target. Also builds dependent targets.
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Build — Compile File Runs make filename.o from the directory where file-
name is the name of the currently opened file. TODO better formulation

Build — Run Configure Run Configure

Build — Run automake & friends Executes

1. make -f Makefile.cvs
2. ./configure

commands from the project directory.
Build — Install Runs make install command from the project directory.

Build — Install (as root user) Asks the user for the root password using kdesu
and then runs make install as root user.

Build — Clean project Runs make clean command from the project directory.
Build — Distclean Runs make distclean command from the project directory.

Build — Make Messages & Merge (Shift+F9) Runs make packages-messages
command from the project directory.

Build — Execute Program Executes program specified in project settings, Run
Options tab. If it is not specified there then the active target is used to
determine the application to run.

Build — Build API Documentation Runs doxygen on a project Doxyfile to gen-
erate API documentation. If the search engine is enabled in Doxyfile, this
also runs doxytag to create it.

Build — Clean API Documentation Removes all files generated by doxygen.

Build — Stop (Escape) Stop application started with the Execute menuitem
above, and all running processes started by KDevelop like building pro-
cess, grep command etc.

On the toolbar, this action provides a popup menu to choose a process to
stop.

G.1.6 The Debug Menu

Debug — Start Start

Debug — Stop Stop

Debug — Interrupt Interrupt

Debug — Run to Cursor Run to Cursor
Debug — Step Over Step Over

Debug — Step over Instruction Step over Instruction
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Debug — Step Into Step Into

Debug — Step into Instruction Step into Instruction

Debug — Step Out Step Out

Debug — Toggle Breakpoint Toggle Breakpoint

Debug — Viewers Viewers

Debug — Examine Core File... Examine Core File...

Debug — Attach to Process Attach to Process

Debug — Valgrind Memory Leak Check Valgrind Memory Leak Check
Debug — Profile with KCachegrind Profile with KCachegrind

G.1.7 The Bookmarks Menu

Bookmarks — Set Bookmark (Ctrl+B) Add current selection to your bookmarks.

Bookmarks — Clear All Bookmarks Clear All Bookmarks.

G.1.8 The Window Menu

Window — Close Selected Windows... (Alt+W) Close Selected Windows...
Window — Close (Ctrl+F4) Close

Window — Close All Close All

Window — Close All Others Close All Others

G.1.9 The Tools Menu

Tools — Read Only Mode Read Only Mode

Tools — Filetype Mode Filetype Mode

Tools — Highlight Mode Highlight Mode

Tools — Set Encoding Set Encoding (former View menu?))
Tools — End of Line End of Line

Tools — Spelling Spelling

Tools — Indent (Ctrl+I) Indent

Tools — unindent (Ctrl+Shift+I) unindent
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Tools — Clean Indentation Clean Indentation
Tools — Align (Ctrl+Tab) Align

Tools — Comment (Ctrl+D) Comment
Tools — Uncomment (Ctrl+Shift+D) Uncomment

Tools — Uppercase (Ctrl+U) Uppercase

Tools — Lowercase (Ctrl+Shift+U) Lowercase

Tools — Capitalize (Alt+Ctrl+U) Capitalize

Tools — Join Lines (Ctrl+]) Join Lines

Tools — Word Wrap Document Word Wrap Document

Tools — Difference Viewer... Difference Viewer...
Tools — Execute Command... Execute Command...

Tools — Filter Selection Through Command... Filters selection through exter-
nal command using the Filter plugin.

Tools — Debug Regular Expression... Debug Regular Expression...

Tools — Part Explorer Part Explorer

Tools — Quick Open Class... (Alt+Ctrl+C) Quick Open Class...

Tools — Quick Open Method... (Alt+Ctrl+M) Quick Open Method...
Tools — Preview Doxygen Output (Alt+Ctrl+P) Preview Doxygen Output

Tools — Document Current Function (Ctrl+Shift+S) Document Current Func-
tion

G.1.10 The Settings Menu

Settings — Show/Hide Menubar (Ctrl+M) Show/Hide the menubar.

Settings — Toolbars Opens a sub menu where you can choose to show or hide
the various Toolbars.

Settings — Show Statusbar Show the Statusbar.

Settings — Configure Shortcuts... Configure Shortcuts...
Settings — Configure Toolbar... Configure Toolbar...

Settings — Configure Notifications... Configure Notifications...
Settings — Configure Editor... Configure Editor...

Settings — Configure KDevelop... Configure KDevelop...
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G.1.11 The Help Menu

Help — KDevelop Handbook View this document.

Help — What's This? (Shift+F1) Draws a question mark (?) beside the mouse
pointer, clicking on a window item such as the Stop button will then dis-
play a brief explanation.

Help — Tip of the Day Tip of the Day

Help — Look in Documentation Index... (Alt+Ctrl+I) Look in Documentation
Index...

Help — Search in Documentation... (Alt+Ctrl+S) Search in Documentation...
Help — Man Page... Man Page...

Help — Info Page... Info Page...

Help — Report Bug... Report bug.

Help — About KDevelop... Display some brief information about KDevelop’s
version number, authors and license agreement.

Help — About KDE... Show some information about the version of KDE that
you are running.
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Appendix H

Further Information

H.1 Getting Information

(... to be written ...)

H.2 Reporting Bugs

(... to be written ...)

H.3 Licensing

This documentation is licensed under the terms of the GNU Free Documenta-
tion License.

This program is licensed under the terms of the GNU General Public License.
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Appendix I

Changes

I.1 Changes to This Document

e 2003-01-03 — Started this Changelog

2005-05-02 Many changes by Volker Paul, including;:

e split into one file per chapter/appendix

e added command reference sorted by menu (descriptions not yet complete)
o AppWizard tutorial in getting-started.docbook

e Reorganized chapters, guided by Konqueror manual

e Moved installation, Unix development, "In a Nutshell" to the appendix

e Rewrote plugin appendix, incl. plugin list generator listplugins.sh

Still far from complete, but a small step forward.
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(... to be written ...)

J.0.0.0.0.1 Bibliography

[1
[2] David MacKenzie and Tom Tromey, GNU Automake

Richard M. Stallman and Roland McGrath, GNU Make Manual

]
]

[3] David MacKenzie and Ben Elliston, GNU Autoconf

[4] Richard M. Stallman, Using the GNU Compiler Collection
]

[5] Gordon Matzigkeit, Alexandre Oliva, Thomas Tanner, and
Gary V. Vaughan, GNU Libtool

[6] Gary V. Vaughan, Ben Elliston, Tom Tromey, and Ian Lance
Taylor, GNU Autoconf, Automake, and Libtool, 1st edition, Octo-
ber 2000, New Riders Publishing, ISBN 1578701902.

[7] W. Richard Stevens, Advanced Programming in the UNIX® En-
vironment, 1st edition, June 1992, Addison-Wesley Pub Co,
ISBN 0201563177.

[8] Bruce Eckel, Thinking in C++, Volume 1: Introduction to Stan-
dard C++, 2nd Edition, April 15, 2000, Prentice Hall, ISBN
0139798099.

[9] Karl Fogel and Moshe Bar, Open Source Development with CVS,
2nd Edition, October 12, 2001, The Coriolis Group, ISBN
158880173X.

[10] Rasmus Lerdorf and Kevin Tatroe, Programming PHP, 1st edi-
tion, March 2002, O'Reilly & Associates, ISBN 1565926102.

153


info://make/Top
info://automake/Top
info://autoconf/Top
info://gcc/Top
info://libtool/Top

KDevelop User Manual

[11] Mark Lutz, Programming Python, 2nd Edition, March 2001,
O'Reilly & Associates, ISBN 0596000855.

[12] Boudewijn Rempt, Gui Programming With Python : Using the
Qt™ Toolkit, Bk&Cd-r edition, January 2002, Opendocs Llc,
ISBN 0970033044.

[13] Larry Wall, Tom Christiansen, and Jon Orwant, Programming
Perl, The Camel book, 3rd Edition, July 2000, O'Reilly & Asso-
ciates, ISBN 0596000278.

[14] Randal L. Schwartz and Tom Phoenix, Learning Perl, The Lama
book, 3rd Edition, July 15, 2001, O’Reilly & Associates, ISBN
0596001320.

154



KDevelop User Manual

Appendix K
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projects, 14
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API, 108

config.h.in, 91
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cross compiling, 93
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D
Database
new project, 55

database
CVS

DCOP, 115
debugger, 95
debugger toolbar, 97
debugging

regular expressions, 135
default build configuration

warning, 65
dependencies, 116
development, 113

IDE, 117

Java, 14
dialog

create new project, 53
directory

project, 55
disassemble, 96
distribution, 14
documentation tool, 134
dot, 103
Doxygen, 134

doxygen, 103

E
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embedded
Qt, 94
environment
DE, 117
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filter, 134
finding, 67
flex

requirements, 103
Fortran

new project, 55
frame stack, 96
framebuffer, 94
full screen mode, 12

G
g++

requirements, 103
gcc

requirements, 103

GNU |
requirements, 103

graphical user interface, 117
GUI, 117

H
Haskell )

new project, 55
hide menubar, 12
history, 113
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integrated development environment,
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new project, 55
projects, 14
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compilation, 104
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update, 102
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language, 54

lazy breakpoints, 97
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make, 116
KDevelop installation, 105
requirements, 103
Makefile, 92, 116
custom projects, 14
Makefile.in, 91
mangling
name, 97

menubar
hide/unhide, 12

Nime

application, 55
name mangling, 97
non-default directory, 107
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obtain KDevelop, 101
overall view, 9

Pascal .
new project, 55

PATH, 104
path
new project, 55
Perl, 114
new project, 55
requirements, 103
PHP, 114
new project, 55
plugins, 130
preliminaries
KDevelop installation, 104
programming language, 54
project
application type, 54
author, 55
create new project
dialog, 53
CVS, 57
directory, 55
email, 55
initial build, 64
language, 54
license, 55
main.cpp, 55
new, 52
build, 64
programming language, 54
properties, 55
templates, 53
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project management, 13
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Python, 114
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Qt
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Tabbed Pages, 10

target, 116

templates
project, 53

edit, 63

toolbar

debugger, 97

Toplevel Windows, 10

U
Ul modes, 10
unhide menubar, 12

UNIX
development, 113

history, 113
pipe, 113
shell, 113

update, 102

user interface
full screen mode, 12
GUI, 117
KDevelop modes, 10
menubar, 12
switch modes, 11, 19
work space, 12

\%
valgrind, 103
version
VS, 57
database, 57

version need
circumvent for autoconf/automake,
104

w
warning

default build configuration, 65
watch variables, 95
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